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Mengakses halaman Edit PKA

Melakukan perubahan data pada halaman Edit PKA
Mengakses fitur hapus PKA

Tampilan konfirmasi menghapus PKA

Mengakses menu List KDA

Memilih kegiatan audit untuk mengakses halaman List KDA
Halaman List KDA

Mengakses fitur KDA Detail

. Tampilan halaman KDA Detail

. Tampilan menu Download PDF/Excel

Mengakses halaman Create KDA

Beberapa field input pada halaman Create KDA

. Tampilan halaman List KDA

Mengakses halaman Edit KDA

Contoh beberapa field data KDA yang dapat diubah
Pesan berhasil mengubah data KDA

Mengakses fitur Delete KDA

Gambar 100. Pesan konfirmasi hapus KDA
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Mengakses halaman Tanggapan KDA

Form Tanggapan KDA

Mengakses halaman Tindak Lanjut KDA

Contoh field Tindak Lanjut KDA

Mengakses halaman Verifikasi Tindak Lanjut KDA
Informasi Summary KDA dan Dokumen Tindak Lanjut
Bagian yang harus diisi verifikator

Mengakses fitur Show/Hide KDA

Pop-up konfirmasi menyembunyikan KDA dari auditee
Mengakses halaman Bukti Pendukung Temuan
Halaman Bukti Pendukung Temuan

Mengakses halaman Rekapitulasi KDA

Tampilan tabel pertama rekapitulasi temuan audit
Mengakses halaman Statistik KDA

Tampilan grafik total temuan per tahun

Mengakses halaman List SPM dari menu navigasi
Mengakses form Create SPM dari halaman List SPM
Form Create SPM bagian Unsur Penilaian

Kolom Nilai Total Akhir hasil dari kalkulasi nilai-nilai yang diinput
Mengakses halaman List SPM dari menu navigasi
Mengakses form Edit SPM dari halaman List SPM
Form Edit SPM bagian Unsur Penilaian

Kolom Nilai Total Akhir yang ter-update setelah perubahan nilai
Mengakses halaman List SPM dari menu navigasi
Mengakses halaman Detail SPM dari halaman List SPM
Halaman Detail SPM

Mengakses form Delete SPM dari halaman List SPM
Pesan konfirmasi menghapus data penilaian SPM
Mengakses menu Cashcount

Form Create Cashcount

Pesan berhasil create cashcount

Mengakses menu Cashcount

Mengakses form edit cashcount

Form edit cashcount
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Pesan sukses berhasil edit cashcount
Mengakses halaman Cashcount Detail

Halaman Cashcount Detail

Mengakses menu List Cashcount dari
Mengakses halaman Delete Cashcount

Pesan konfirmasi penghapusan data cash count

Mengakses halaman List Berita Acara dari menu navigasi

Mengakses form Create Berita Acara dari halaman List Berita Acara

Form Create Berita Acara
Mengakses PDF View file berita acara
Hasil view PDF file berita acara sepakat

Mengakses halaman Edit Berita Acara

Beberapa field yang dapat dirubah pada halaman Edit Berita Acara

Mengakses halaman Rekapitulasi Berita Acara
Tampilan halaman Rekapitulasi Berita Acara
Pop-up detail temuan berita acara
Mengakses menu LHA

Halaman List File LHA

Form Upload File LHA

Pesan alert berhasil upload file LHA

Halaman LHA File Detail

Submenu Action file LHA (Ketua Tim Auditor)
Pop up konfirmasi menghapus file LHA

Form Re-Upload file LHA

Halaman File LHA Detail (Dalnis)

Form Verifikasi File LHA

Form Verifikasi File LHA pilhan Tidak
Mengakses menu Monitoring Progress pada sidebar menu
Halaman Monitoring Progress List

Halaman Monitoring Progress List

Halaman Detail Monitoring Progress

Navigasi ke menu Bahan Pendukung Audit
Halaman List Bahan Pendukung Audit

Form Upload Bahan Pendukung Audit
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Mendownload seluruh file bahan pendukung audit

Mendownload beberapa file bahan pendukung audit
Form Download Confirmation file bahan pendukung audit
Kolom Action dengan tombol View, Download, dan Delete

Form Delete Confirmation untuk menghapus file bahan pendukung audit

Halaman List Work Unit

Form Create Work Unit

Memilih menu Work Unit Detail

Halaman Work Unit Detail

Mengakses halaman Edit Work Unit

Form Edit Work Unit

Select unit kerja pada tabel Work Unit (On/Off)
Halaman Aktivasi/Inaktivasi unit kerja (Inaktivasi)
Halaman Aktivasi/Inaktivasi unit kerja (Aktivasi)
Halaman Audit Competencies Lists

Form Create Audit Competencies

Mengakses halaman Audit Competencies Detail
Halaman Audit Competencies Detail
Mengakses halaman Edit Audit Competencies

Form Edit Audit Competencies

Select unit kerja pada tabel Audit Competencies (On/Off)

Halaman Aktivasi/Inaktivasi Audit Competencies (Inaktivasi)

Halaman Aktivasi/Inaktivasi unit kerja (Aktivasi)
Mengakses menu User Activity Log

Halaman User Activity Log
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1. PENDAHULUAN

1.1 TUJUAN PEMBUATAN DOKUMEN

Dokumen user manual aplikasi Sistem Informasi Audit Internal SPI (SIAIS) ini dibuat
untuk tujuan sebagai berikut:
1. Menggambarkan dan menjelaskan penggunaan aplikasi SIAIS untuk
administrator dan pengguna (user).
2. Sebagai panduan instalasi, konfigurasi, dan penggunaan aplikasi SIAIS ini.
Pihak-pihak yang berkepentingan dan berhak menggunakan dokumen ini yaitu:
1. User Auditor (Internal/Luar SPI)
User Auditor Internal menggunakan dokumen ini untuk mengetahui cara-
cara penggunaan aplikasi SIAIS.
2. User Auditee (UPBJJ/Unit)
User Auditee dari UPBJJ atau Unit Universitas Terbuka untuk mengetahui
cara penggunaak aplikasi SIAIS sebagai auditee
3. Administrator SPI
Administrator SPI menggunakan dokumen ini sebagai panduan untuk
mereka bagaimana menggunakan dan melakukan pemeliharaan untuk

aplikasi SIAIS.

1.2 DESKRIPSI UMUM SISTEM

Deskripsi umum aplikasi meliputi deskripsi umum Sistem Informasi Audit Internal
SPI yang dikembangkan, fungsi utama Sistem Informasi Audit Internal SPI yang akan
diberikan kepada pengguna serta karakteristik pengguna yang meliputi pembagian
kelompok pengguna seperti pekerjaan dan hak akses ke aplikasi. Deskripsi umum
kebutuhan aplikasi yang akan diimplementasikan meliputi semua informasi yang

bersifat teknis yang menjadi acuan dalam pengembangan aplikasi.

1.3 DESKRIPSI DOKUMEN (IKHTISAR)
Dokumen ini dibuat untuk memberikan panduan penggunaan aplikasi Sistem

Informasi Audit Internal SPI. Dokumen ini berisikan informasi sebagai berikut:
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1. BABI.
Berisi perangkat yang dibutuhkan untuk penggunaan aplikasi SIAIS meliputi
perangkat lunak dan perangkat hardware.

2. BABII
Berisi informasi umum yang merupakan bagian pendahuluan, yang
meliputi tujuan pembuatan dokumen, deskripsi umum sistem serta deskripsi
dokumen.

3. BABIII
Berisi user manual aplikasi SIAIS baik user manual yang diperuntukkan untuk

administrator dan user (auditor dan auditee).

1.4 DEFINISI DAN SINGKATAN

e UT : Universitas Terbuka
e SPI : Satuan Pengawas Internal
e SIAIS : Sistem Informasi Audit Internal SPI

e UPBJJ : Unit Program Belajar Jarak Jauh

2. SUMBER DAYA YANG DIBUTUHKAN

2.1 PERANGKAT LUNAK

Perangkat lunak yang digunakan dalam pengembangan aplikasi ini adalah :
e Microsoft Windows 10 64-bit sebagai sistem operasi
e MariaDB 10.1.16 sebagai RDBMS server
e HeidiSQL 11 sebagai database client

e Apache sebagai server aplikasi web

2.2 PERANGKAT KERAS

Perangkat keras yang digunakan dalam pengembangan aplikasi ini adalah :

e Server dengan sepesifikasi Intel core i7-8750H up to 2.2 GHz, RAM minimal 8
GB

e Mouse sebagai peralatan antarmuka
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e Monitor sebagai peralatan antarmuka

o Keyboard sebagai peralatan antarmuka

2.3 SUMBER DAYA MANUSIA

Beberapa kebutuhan bagi sumber daya manusia yang akan menggunakan aplikasi

ini diutamakan harus :

e Memiliki pemahaman dan pengalaman menggunakan antar muka komputer.
Minimal memahami cara penggunaan antar muka sistem operasi Windows

e Memiliki pemahaman dan pengalaman menggunakan tools peramban web
(web browser) untuk mengakses website atau aplikasi berbasis web atau
sejenisnya

e Memiliki pemahaman dan pengalaman proses Audit Internal, khususnya di
lingkungan Universitas Terbuka

e Memiliki pemahaman dan pengalaman menggunakan sistem informasi
berbasis web. Minimal mengerti mengelola sistem informasi dasar, misalnya

data kepegawaian

2.4 PENGENALAN DAN PELATIHAN
Sumber daya manusia yang terlibat dalam operasinal penggunaan aplikasi ini
sehari-hari terlebih dahulu diberikan pengenalan dan pelatihan yang cukup untuk

menggunakan aplikasi SIAIS ini.

3. MENU DAN CARA PENGGUNAAN

3.1 STRUKTUR MENU
Adapun struktur menu pada aplikasi Sistem Informasi Audit Internal SPI (SIAIS)
adalah sebagai berikut:

1. Menu User Account

2. Menu User Role

3. Menu Sign Out
4. Menu Dashboard
5

Menu Profile Management
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10.

11.

12.

13.

14.

15.
16.

17.

a. Menu All Users

b. Menu My Profile

Menu Audit Schedule

a. Menu Audit Activity

b. Menu Other Activity
Menu Kinerja

a. Menu Penilaian Ketua
b. Menu Penilaian Dalnis
c. Menu Penilaian Auditee
Menu Program Kerja Audit
a. Menu List PKA

Menu Kertas Data Audit

a. Menu List KDA

b. Menu Rekapitulasi

c. Menu Statistik KDA
Menu SPM

a. Menu List SPM

b. Menu Statistik SPM
Menu Cashcount

a. Menu List Cashcount
Menu Berita Acara

a. Menu List Berita Acara
b. Menu Rekapitulasi
Menu LHA

Menu Monitoring Progress
Menu Bahan Pendukung Audit
Menu Master Data

a. Menu Unit Kerja

b. Menu Kompetensi Audit

Menu User Activity Log
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3.2 CARA PENGGUNAAN APLIKASI
3.2.1 Cara Mengakses Aplikasi
Untuk memulai akses pada aplikasi SIAIS, tahapannya sebagai berikut:
1. Buka aplikasi SIAIS melalui web browser Chrome atau Mozilla Firefox dengan

alamat url https://siais.ut.ac.id

2. Tekan Enter pada keyboard atau klik tombol Go pada browser
3. Kemudian akan muncul tampilan halaman depan aplikasi SIAIS seperti berikut

ini:

SIAIS UT

SIGN IN

Lupa Password ?

Gambar 1. Halaman login aplikasi SIAIS
4. Masukkan Username dan Password, misalnya Username: administrator dan
Password: admin123. Setelah dimasukkan dengan benar, klik tombol Sign In
atau tekan Enter pada Keyboard, jika berhasil akan diarahkan langsung ke

halaman utama yaitu Dashboard aplikasi SIAIS.

SIAIS UT

Gambar 2. Halaman Dashboard

5. lJika kredensial yang dimasukkan salah, akan muncul pesan error seperti

berikut :
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https://siais.ut.ac.id/

SIAIS UT

© Username atau Password tidak valid.

SIGNIN

Lupa Password ?

Gambar 3. Pesan error gagal login

3.2.2 Menu Dashboard

Dashbbérd

akses cepat ke menu tertentu section notifikasi (LHA/Riwayat Pelatihan)

8| & B | 6

My Profile Audit Schedule <DA Rekap Temuan Berita Acara

B

LHA

menu akses ke aplikasi luar (manisku)
v

A

Manisku

Gambar 4. Informasi bagian halaman Dashboard

Pada halaman Dashboard, terdapat tombol-tombol yang bisa digunakan
untuk mengakses cepat ke menu-menu tertentu, dan tombol integrasi
dengan aplikasi luar yaitu Manisku, serta di sisi kanan halaman adalah
bagian notifikasi dari aplikasi SIAIS (notifikasi Verifikasi File LHA dan

notifikasi melengkapi Riwayat Pelatihan/Seminar/Workshop)
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Warning!

Lengkapi informasi riwayat Training/Seminar/Kompetensi
Anda dan upload file sertifikat jika ada pada halaman My
Profile > klik tombol "Edit .

Gambar 5. Tampilan notifikasi pengingat mengisi Riwayat Pelatihan

Warning!

Lakukan Verifikasi file LHA pada halaman ini untuk kegiatan

audit:

e Audit Kegiatan Operasional UPBJJ-UT Aceh

» Kegiatan Audit Operasional Awal Tahun 2019 UPBJJ-UT
Serang

e Audit Operasional Awal Tahun UPBJJ-UT Batam

Gambar 6. Tampilan notifikasi pengingat Verifikasi File LHA

3.2.3 Menu User Application Management
I.  User Account Management
Menu ini hanya dapat diakses oleh role bertipe Admin. Menu User Account
Management adalah menu vyang memungkinkan kita untuk mengatur

penambahan, perubahan, dan aktivasi/inaktivasi data user dari aplikasi SIAIS.

Tambah User Account
Untuk melakukan penambahan user aplikasi baru, tahapannya sebagai berikut :
1. Di halaman Dashboard SIAIS, klik menu User Account yang terletak pada sisi

pojok kanan atas halaman (di atas tombol Sign Out)

J3Ie Trie Afia Farid, S.Kom - USR0001

User Account
, User Role
08.08.20 Signout

Gambar 7. Menu User Account
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©
2. Pada halaman User Account Lists klik tombol Create untuk mulai

membuat User Account yang baru

# 5 User Management > User Account

Usér Account Lists
HEAE

Show 10 v enlries

No. USERID USERNAME CREATEDBY

1 USRO001 tieafia system at Dec/01/2018 06:11
2 USROD02 yun iswanto trie.afia 51 Dec/01/2016 06 18
3 USRO003 heryanni wrie.afia 51 Dec/01/2016 06 29
4 USR0004 thini fatmasari trie.afia at Dec/01/2018 06:31
5 USRO00S wivin siswantini trie.ofia a1 Dec/01/2018 0633
6 USRO006 antonio.vivaldi trie.afia at Dec/01/2018 06.34
7 USRO00T iyadi wahyu trie.afia at Dec/01/2018 06.36
8 USHO0S ahmad binadi trie.afia a1 Dec/01/2018 0638
9 USRO009 tiyas hayu trie.afia at Dec/01/2018 0639
10 USROD10 nur dian trie.afia a1 Dec/01/2018 0642

Shiowing 11010 of 75 entries

Search
MODIFIEDBY STATUS
system at May/27/2021 11:15
none [ ]
none =
none
nane
trie.afia at Fev/16/2019 17:15
e
eyetem ar Mar/28/2021 1313
none
one

2 4 Next | tast

Gambar 8a. Halaman User Account Lists

3. Pada halaman Create User Account silakan isikan data-data user sesuai yang

diminta, seperti Username, Password, User Role serta data pendukungnya

& Primary Information

User ID * USR0081
Max. 20 characters length of User ID
Username * fqodry
Password * ssccsscssocce
esccecssccoce
User Role * Auditor SPI X

First Name *

Firman
Last Name * Qodry
Gender » Male

+ Additional Information

Gambar 8b. Form Tambah User Account

4. lJika sudah selesai mengisi, submit form dengan mengklik tombol Submit

Lihat Detail User Account

Kita bisa melihat data detail dari User Account yang sudah dibuat sebelumnya,

yaitu dengan mengakses halaman User Account Detail. Caranya sebagai berikut :
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1. Pertama-tama pastikan kita sudah berada pada halaman User Account Lists

> Us 1> User Account
o
on/off

Show 1) v entries Search

No. USERID USERNAME CREATED BY MODIFIEDBY STATUS

1 USR0001 e afia ‘system at Dec/01/2018 06:11 system at May/27/202] 1115 =3
2 USR0002 yun.iswanto trie.afia at Dec/01/2018 06:18 none [ acrve |
3 USR0003 heriyanni trie.afia at Dec/01/2018 06:29 none | acre |
4 USR0004 rhini fatmasari trie.afia at Dec/01/2018 06:31 none ACTIVE

5 USR000S ‘wiwin siswantini trie.afia at Dec/01/2018 0633 none

6 USR0006 ‘antonio vivaldi trie.afia a1 Dec/01/2018 06:34 trie.afi a1 Feb/16/2019 1715
7 USR0007 riyadiwahyu trie.afi at Dec/01/2018 06:36 none
8 USR0008 ahmad binadi trie.afia at Dec/01/2018 06:38 system at Mar/28/2021 13:13 | scrve |
9 USR0009 riyas hayu trie.afia at Dec/01/2018 06:39 nane
10 USR0010 nur dian trie.afia at Dec/01/2018 0642 none
Showing 11010 0f 75 entries 23 4|5 N Lest

Gambar 9. Halaman User Account Lists
2. Kemudian pilih User yang ingin kita lihat datanya dengan klik area pada baris
data User pada tabel User Account sampai barisnya terpilih (terlihat area

barisnya lebih gelap). Misal pada guide ini kita pilih data user ‘rhini.fatmasari’

# 5 User Management > User Account

User Account Lists
Edit On/Off
Show

10" v entries

Search:

NO. USERID USERNAME CREATEDBY MODIFIED BY STATUS

1 USR0001 trie afia system at Dec/01/2018 0611 system at May/27/2021 11.15
2 USR0002 yun.iswanto trie.afia at Dec/01/2018 06:18 none | acrive |
3 USR0003 heryanni trie.afia a1 Dec/01/2018 06.29 ‘none ACTIVE

4 USR0004 thini faumasari trie.afia at Dec/01/2018 06:31 none | acnive |
5 USR0005 wiwin siswantini trie.afia at Dec/01/2018 0633 none [ acrive |
6 USR0006 antonio vivaldi trie.afia at Dec/01/2018 06.34 tie.afia at Feb/16/2019 1715 ACTIVE

7 USR0007 tiyadi wahyu wie.afia at Dec/01/2018 06:36 none EE
8 USR0008 ahmad binadi trie.afia at Dec/01/2018 06 38 system at Mar/28/2021 1313
9 USR0009 riyas.hayu trie.afia at Dec/01/2018 06:39 none
10 USRO010 nur dian trie.afia at Dec/01/2018 0647 none ACTIVE

Showing 1 to 10 of 75 entries - 2 3 4 S5 Next Last

Gambar 10. Select User pada tabel User Account (View)

@
View

3. Lalu klik tombol View untuk mulai melihat data detail User Account
kita
4. Selanjutnya akan tampil halaman User Account Detail yang berisi data detail

User Account yang sudah kita pilih
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# ) User Management > User Account » Detall

User Account Detail

® Primary Information

User D USR0004
KEY 'VALUE
Ma or 1D
Created By tric afia
Created Date 2018-12-01 06:31:25
Username
h fau 3l
thint fatmasari T
Modified Date
Password | eeeeseesccess
User Role
Active

Gambar 11. Halaman User Account Detail

Ubah Data User Account
Untuk merubah data User Account yang sudah kita buat sebelumnya, tahapannya
adalah sebagai berikut :
1. Pertama-tama pastikan kita sudah berada pada halaman User Account Lists
2. Kemudian pilih User yang ingin kita ubah datanya dengan klik area pada baris
data User pada tabel User Account sampai barisnya terpilih (terlihat area
barisnya lebih gelap). Misal pada guide ini kita pilih data user ‘rhini.fatmasari’

untuk merubahnya

# > User Management > User Account

User Account Lists
View Create Edit On/Off

Show 10 v entries

Search

NO. USERID USERNAME CREATED BY MODIFIED BY STATUS

1 USR000T ie afia system at Dec/01/2018 0611 system at May/27/2021 11:15 [ acve |
2 USR0002 yun.iswanto trie.afia at Dec/01/2018 06:18 none [ acTive |
3 USR0003 heriyanni trie.afia at Dec/01/2018 06:29 none
4 USR0004 hini fatmasari trie.afia at Dec/01/2018 06:31 none
5 USR0005 wiwin.siswantini trie.afia at Dec/01/2018 06:33 none
6 USR0006 anoniovivaldi rie.affa at Dec/01/2018 0634 trie.afia at Feb/16/2019 17.15
7 USR0007 riyadi wahyu trie.afia at Dec/01/2018 06:36 none
8 USR0008 ahmad binadi trie.afia at Dec/01/2018 0638 system at Mar/26/2021 13,13 | acrive |
9 USR0009 riyas.hayu trie.afia at Dec/01/2018 06:39 none
10 USR0010 nurdian tie.affa at Dec/01/2018 06:42 none ACTIVE

Showing 1 1o 10 of 75 entries

Gambar 12. Select user pada tabel User Account (Edit)

s
3. Lalu klik tombol Edit untuk mulai melakukan perubahan data terhadap

user tesebut
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4. Pada halaman Edit User Account, kita dapat melakukan perubahan data

Password dengan memasukkan data field New Password dan Retype New

Password serta perubahan data User Role pada form Edit User Account

# > User Management > User Account > Edit

User Aécount Edit
HEES

¢ Detail Information

UserID * USR0004

Max. 20 characters length of User ID

Username * rhini.fatmasari

Password * ecccccscccccscce

New Password

Retype New Password *kolom yang dapat

diubah datanya

{User Role * Auditor SPI X || Pengendali Teknis X

Gambar 13. Halaman Edit User Account

5. Setelah selesai mengisi form, lakukan submit dengan klik tombol Submit

Mengaktifkan Atau Menonaktifkan User Account

Jika User Account aplikasi SIAIS sudah tidak digunakan lagi, kita dapat melakukan

inaktivasi user tersebut. Begitupun sebaliknya, jika kita ingin mengaktifkan kembali

user yang berstatus tidak aktif kita dapat mengaktifkannya. Caranya adalah sebagai

berikut :

1.

Sama seperti melihat dan merubah data User Account, pastikan kita sudah

berada pada menu User Account Lists

Kemudian pilih User yang ingin kita aktivasi/inaktivasi dengan klik area pada

baris data User pada tabel User Account sampai barisnya terpilih (terlihat

area barisnya lebih gelap). Misal pada guide ini kita pilih data user

‘rhini.fatmasari’ untuk merubahnya
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# 5 User Management > User Account

Usér Account Lists
EEE

Show 10 v entries Search.

[ USERID USERNAME CREATEDBY MODIFIED BY STATUS

) UsHoo0! e aia system a1 Dec/01/2018.06:11 systom at May/27/2021 11:15
2 USR0002 yun.iswanto trie.afia at Dec/01/2018 06:18 none
3 UsAo003 eriyonnd wi.afia o1 Dec/01/2018 0629 one [ Acnve |
4 USRO004 shini fatmasari trie.afia ar Dec/01/2018 06:31 none
5 USRO005 wi ntini trie.afia at Dec/01/2018 06:33 none
6 USR0006 antonio.vivaldi trie.afia at Dec/01/2018 06:34 trie.afia at Fcb/16/2019 17.15
7 USR0007 riyadi wahyu trie.afia a1 Dec/01/2018 06:36 none
8 USRO008 ahmad binadi trie.afia at Dec/01/2018 06:38 system ot Mar/28/2021 1313 AcTIvE
9 USR0009 riyas hayu trie.afia at Dec/01/2018 06:39 none =3
10 USRO010 nurdian trie.afia at Dec/01/2018 06:42 none | acrve |
Showing 11010 of 75 entries - 2 4 5| nen | tam

Gambar 14. Select user pada tabel User Account (On/Off)

0]
3. Lalu klik tombol On/Off untuk mulai melakukan Aktivasi/Inaktivasi
User Account tersebut
4. Pada halaman Activate/Inactivate User Account perhatikan Warning
Message. Jika awalnya akun berstatus Active, maka seharusnya pesan yang
tertulis adalah suatu konfirmasi bahwa benar kita akan melakukan Inactivate

(Inaktivasi) terhadap User Account tersebut

# > User Management > User Account > Activate/Inactivate

ACtiQéfé/Inactivate User Account

& Primary Information

Auention!
You are about to Inactivate this Role by clicking "OnlOff” button
UseriD USR0004
Max. 20 characters length of User ID

Usemame rhini_fatmasari
Password 9000000000000000
User Role

Active

Gambar 15. Halaman Aktivasi/inaktivasi User Account (Inaktivasi)
5. Begitupun sebaliknya, jika status awal akun Inactive, maka seharusnya pesan
yang tertulis adalah suatu konfirmasi bahwa benar kita akan melakukan

Activate (Aktivasi) terhadap User Account tersebut
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# ) User Management > User Account ) Activate/Inactivate

Awbtriv\»/é;[ve/lnactivate User Account

O
Back

o
Onjoff

4 Primary Information

Attention!

User ID

Username

Password

User Role

You are about to Activate this Role by clicking "OnjOff" button

USR0004

Max. 20 characters length of User ID

rhini_fatmasari

Active

Gambar 16. Halaman Aktivasi/Inaktivasi User Account (Aktivasi)

6. Jika sudah yakin akan Aktivasi/Inaktivasi User Account, silakan klik tombol

o
On/Off untuk submit form

3.2.4 Menu Profile Management

I. Menu All Users

Halaman yang berisi informasi data profil seluruh user auditor dan auditee. Di

halaman ini kita bisa melihat detail informasi profil user, mengubah data profil kita

sendiri, dan khusus untuk role Admin diberikan akses untuk bisa mengubah profil

user lain.

@ 3 Profile Management  All Users

@ User Pfoﬁle Lists
HEE

Show 10 v enlries

NO. STAFFID NIP

1

2

3

4

5

6

STAFO001 199006212016TKTD059

STAFD002

STAFO003

STAFO004

STAFO00S

GOLONGAN  STAFFNAME WORK UNIT
/a Trie Afia Farid, SKom  SPI - Satuan Pengawas Internal
Drs. Yunlswanto,MSi  SPI - Satuan Pengawas Internal
SPI - Satuan Pe
SE.MM
D« Rhini Fatmasai, SPI - Satuan Pengawas Internal
SPd.MSc
Dia. L SPI-S
MM

STAFOD06 123456789101112TKTO1  iva

Antonio Vivaldi, S E SPI- Satuan Pengawas Internal

EMPLOYMENT
STATUS

T

Pegawai Negeri Sipil
(PNS)
Pegawai Negeri Sipil
(PNS)
Pegawai Negeri Sipil
(PNS)
Pegawai Negerl Sipil
(PNS)

Pegawai Neger| Sipil
(PNS)

CREATED BY

system at
Dec/01/2018 06:13
trie.afia at
Dec/01/2018 0618
trie.afia at
Dec/01/2018 0629
wio.afi at
Dec/01/2018 06:31
tri.afis at
Dec/01/201806:33
wie.afis ar
Dec/01/2018 06:34

Gambar 17. Halaman User Profile Lists

Search

MODIFIED BY

trie.afia at Jun/20/2021
1447

yun.iswanto at Apr/20/2021
0619

trie.affa at Dec/01/2018
0630

tie.afia o Dec/01/2018
0632

trie.affa ai Dec/01/2018
0634

‘antonio.viveldi 51
Sep/02/2020 1244

STATUS

B
IEBEBAEN

Buku Petunjuk Penggunaan Aplikasi
SISTEM INFORMASI AUDIT INTERNAL SPI

Hal 24 dari 106



Melihat Detail Profil User

Untuk melihat detail profil user caranya adalah sebagai berikut :

1. Akses halaman User Profile Lists yaitu dengan klik dropdown menu Profile

Management lalu klik menu All Users

Show 10 v entries

NO. STAFFID NIP GOLONGAN  STAFF NAME WORKUNIT

1 STAFODDI 195006212016TKT00S9  fija Trie Afia Farid, S Kom  SP1 - Satuan Pengawas Intemal

2 staroo02 Drs. Yun Iswanio, MSi SPI - Satuan Pengawas Intemal

3 STAFODD3 Heriyanni Mashithoh,  SPI - Satuan Pengawas Intemal
SEMM

4 STAFOO0A

5 STAFO00S

6 STAFOD0G 123456789101112TKTOT  lilia

SPI - Satwan Pengawas Intemal

EMPLOYMENT
STATUS

"

Pegama Negest Sipl

(PNS)

Pegawiai Negeri Sipil
(PNS)

Pegawai Negeri Sipi

il tri.af

Search

CREATEDBY

systom at

MODIFIED BY

Dec/01/20180613  14:

rie.afia a
Dec/01/2018 06,18
rie.afia a1
Dec/01/2018 06.29
trie.afia at
Dec/01/2018 06 31

Dec/t)

180623

il trie.afia ar

Dec/01/2018 06.34

Gambar 18. Halaman User Profile Lists

yun.iewanto at Apr/20/2021
0619
ie.afia a1 Dec/01/2018
0630

tre.fia at Dec/01/2018
o637

trie.afia at Dec/01/2018
o634

2. Kemudian pilih data user profile yang ingin kita lihat detailnya dengan cara

klik area pada baris data User pada tabel User Profile sampai barisnya terpilih

(terlihat area barisnya lebih gelap). Misal pada guide ini kita pilih profil user

‘Riyadi Wahyu Wardhana, S.E."

# > Profile Management > All Users

@ User Profile Lists

Show 10 v entries

| STAFODOI 1390062120161KIO0SS /s
2 STAFO002
3 sTaro003
4 sTAFODOS
5 STAFODOS

6 STAFODO6 123456789101112TKTO1 e

NO. STAFFID NIP GOLONGAN STAFFNAME

Trie Afla Fand, SKom  SPI

Drs sP1
Heriyanni Mashithoh,  SPI
SE.MM

Dr Rhini Farmasari sPi-
SPd,MSc

Dra. Wiwin Siswanuni,  SPI
MM

Antonio Vivaldi, § £ SPI-

- Sawan Pengawas Intemal

WORK UNIT

Satuan Pengawas Internal

Satuan Pengawas Internal

Satuan Pengawas Internal

Satuan Pengawas Intermal

EMPLOYMENT
STATUS

TKT

Pegawai Negeri Sipil
(PNS)
Pegawai Negen Sipil
(PNS)
Peqgawai Negeri Sipil
(PNS)
Pegawai Negen Sipil
(PNS)
Pegawai Neger Sipil
(PNS)

CREATED BY

system at
Dec/01/2018 0613
trie.afia at
Dec/01/2018 0618
trie.afi at
Dec/01/2018 06:20
trie.afia at
Dec/01/2018 0631
trie.afia at
Dec/01/2018 06:33
trie.afia at
Dec/01/2018 0634

Search.

MODIFIED BY

trie.afia at Jun/20/2021
1447

yun iswanto at Ap/20/2021

0619
trie.affa at Dec/01/2018
0630

trie.afia at Dec/01/2018
0632

trie.afia at Dec/01/2018
0631

antonio.vivaldi at
5ep/02/2020 12:44

STATUS

(PNS)

Dec/01/2018 06:38

7 STAFODOT 1234567891011125PI03 Riyads Wahyu Wardhana, P! - Satuan Pengawas Internal Pegawai Negeri Sipl  trie.afia at tie.afia at Dec/01/2018
SE (PNS) Dec/01/201806:36 0637
8 STAFODOB  112233445566AGT01 Ahmad Binady, S SPI - Satwan Pengawas Internal Pegawai Negen Sipil  trie.afia at trie.afia at Nov/26/2020

0750

Gambar 19. Mengakses halaman User Profile Detail

3. Setelah itu klik tombol View

@
View

Detail yang berisi data-data detail dari user tersebut

, maka akan tampil halaman User Profile
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# > Profile Management 5 All Users > Profile Detal

@ USGI" Profile Detail

Riyadi Wahyu Wardhana, S.E

& Personal Information

Staff I STAFO007
1234567891011 125PI03
Golongan

First Name Riyadi

2

Wk Homa. Riyadh

Last Name Wahyu Wardhana, S.E

Sendai; Male v

Educatio

Competency
Email

Gambar 20. Halaman User Profile Detail

Merubah Data Profil User

Proses merubah data profile user hanya bisa dilakukan oleh user itu sendiri dan
role Admin. Khusus role Admin dapat merubah data profile semua user. Tahap
untuk merubah data profile user adalah sebagai berikut :

1. Pastikan kita sudah berada pada halaman User Profile Lists. Kemudian pilih
data user profile yang ingin kita ubah datanya dengan cara klik area pada
baris data User pada tabel User Profile sampai barisnya terpilih (terlihat area
barisnya lebih gelap). Misal pada guide ini kita pilih profil user "Riyadi Wahyu
Wardhana, S.E."

# > Profile Management  All Users

@ User Profile Lists

Show 10 v entries Search.
EMPLOYMENT
NO. STAFFID NIP GOLONGAN  STAFFNAME WORK UNIT STATUS CREATED BY MODIFIED BY STATUS
1 STAFDOO1 199006212016TKT0059  Ill/a Trie Afia Farid, SKom P! - Satuan Pengawas Internal Ly system at trie.afia at Jun/20/2021 =3
Dec/01/201806:13 1447
2 STAFOO02 Drs. Yun Iswanto, MSi  SPI - Satuan Pengawas Internal Pegawai Negeri Sipil  trie.afia at yun.iswanto a1 Apr/20/2021
FNS) Dec/01/20180618 0619
3 sTaRoons Heryanni Mashithoh,  SPI - Satuan Pengawas Internal Pegawai Negen Sipil _ ria.afi ot wi.afia 1 Dec/01/2018
SE,MM °NS) Dec/01/20180629  06:30
4 STAF0004 Or. Rhini Faimasai SP1 - Satuan Pengawas Intermal Pegawai Negen Sipil  trie.afia at trie.afia at Dec/01/2018 [ rcve |
SPd,MSc PNS) Dec/01/2018 0631 06:32
STAFD00S Dra. Wiwin Siswantini,  SPI - Satuan Pengawas Internal Pegawai Negeri Sipil  trie.afia at trie.afia at Dec/01/2018
MM (PNS) Dec/01/20180633 0634
6  STAFOOU6 123456789101112TKTO1 iV Antonio Vivaldi, S E SPI - Satuan Pengawas Internal Pegawai Negeri Sipil  trie.afia at antonio.vivaldi at =3
(PNS) Dec/01/201806.34  Sep/02/2020 1244
7 STAFO007 1234567891011125PI03 Riyadi v SPI- [ | trie.afia a1 wie.afi at Dec/01/2018
SE (PNS) Dec/01/201806:36 0637
B STATO008 T12233445566AGT0 Thmad Binadi, S T 5P~ Samua Toternal Tegawai Negen SOl trie.afia ot re.afia ot Nov/ 26/2020
PNS) Dec/01/2018 0638 0750

Gambar 21. Mengakses halaman Edit User Profile

4

2. Kemudian klik tombol Edit MM Saat ini seharusnya kita sudah berada

pada halaman Edit User Profile
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@ Edit User Profile

Riyadi Wahyu Wardhana, S £ & Personal Information

Statt I STAF0007
NIP 1234567891011 125P103
Golongan
First Name Riyadi
yu Wardhana, S £

it iz

Personal

Gambar 22. Form Edit User Profile
3. Silakan melakukan perubahan data profile sesuai keinginan Anda. Di halaman
ini Anda dapat merubah data personal, riwayat pendidikan, kompetensi, dan

riwayat training/seminar

Personal
Education
Competency

Training/Seminar

Gambar 23. List bagian data yang bisa diubah

4, Setelah selesai merubah data klik tombol Submit untuk konfirmasi

perubahan data

Mengaktifkan Atau Menonaktifkan Profil User
Fitur ini hanya dapat diakses oleh role Admin saja. Untuk mengaktifkan atau
menonaktifkan profil user caranya adalah sebagai berikut :

1. Pastikan kita sudah berada pada halaman User Profile Lists. Kemudian pilih
data user profile yang ingin kita aktifkan/non-aktifkan datanya dengan cara
klik area pada baris data User pada tabel User Profile sampai barisnya terpilih
(terlihat area barisnya lebih gelap). Misal pada guide ini kita pilih profil user
‘Riyadi Wahyu Wardhana, S.E.”
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@ > Profile Management 5 All Users
® r'd o
View Edit Onfoff
Show 10 v entries Search
EMPLOYMENT
NO. STAFFID NIP GOLONGAN STAFFNAME WORK UNIT STATUS CREATEDBY MODIFIED BY STATUS
1 STAFODO1 199006212016TKT00S9  Ili/a Trie Afia Farid, SKom  SPI - Satuan Pengawas Internal T®T system ar trie.afia af Jun/20/2021
Dec/01/20180613 1447
2 STAR002 Drs. Yun lswanto, MSi SP! - Sawan Pengawss Intemal Pegowai Negeri Sipl | ri.afia at yomswanto ot Apr/ 202071 |
(PNS) Dec/01/20180618 0619
3 STAFO003 Hesiyanni Mashithoh,  SPI - Satuan Pengawas Internal Pegawai Negeri Sipil  trie.afia at wrie.afia a1 Dec/01/2018
SE.MM (PNS) Dec/01/20180629 0630
4 sTarooos Dr AimFamasad,  SPI- Satuan Pengawas lntesnal Pegawai Negeri Sipl | erie.afie at rie.afia a1 Dec/01/2018
SPd,MSc (NS) Dec/01/20180631 0632
5 STAF0005 Dra. Wiwin Siswanun,  SPI - Satwan Pengawas Internal Pegawai Negeri Sipil  trie.afia at trie.afia at Dec/01/2018 =
MM. (PNS) Dec/01/20180633 0634
6  STAFD00G 123456789101112TKTO1  W/a Antonio Vivaldi, S E SPI - Satuan Pengawas Internal Pegawai Negeri Sipil  trie.afia at antonio. viveldi at | scrive |
(PNS) Dec/01/2018 0634 Sep/02/2020 1244
7 STAFODO7 123456789101112S5PI03 Riyadi Wahyu Wardhana, SPI - Satuan Pengawas Internal Pegawai Negeri Sipil  trie.afia at trie.afia at Dec/01/2018
SE (eNs) Dec/01/201806:36  06:37
¥ STAFODOR 17 Ahmad Binadi S ST~ Satuan Pengawas Intemnal TPl wrie.afia ot Trie-afia 3t Nov/26/2020
(PNS) Dec/01/20180638 0750

Gambar 24. Mengakses halaman Activate/Inactivate User Profile

(V]
2. Kemudian klik tombol On/Off . Saat ini seharusnya kita sudah berada
pada halaman Activate/Inactivate User Profile
3. Pada halaman Activate/Inactivate User Profile perhatikan Warning Message.
Jika awalnya profil berstatus Active, maka seharusnya pesan yang tertulis
adalah suatu konfirmasi bahwa benar kita akan melakukan Inactivate

(Inaktivasi) terhadap User Profile tersebut

" AllUsers 0 e

@ Activafe/lnactlvate User Profile

Auention!
hieking “OnlOF” bimon

You are ahe vate his User Profile
Riyadi Wahyu Wardhana, S & Personal Information

Gambar 25. Menonaktifkan User Profile

4. Begitupun sebaliknya, jika status awal profil adalah Inactive, maka seharusnya
pesan yang tertulis adalah suatu konfirmasi bahwa benar kita akan melakukan

Activate (Aktivasi) terhadap User Profile tersebut

- Al Users

@ Activate/Inactivate User Profile

Anention!
You are about to Activate this User Profile by clicking ORIOf button

Gambar 26. Mengaktifkan User Profile
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5. lJika sudah yakin akan Aktivasi/Inaktivasi User Profile, silakan klik tombol

On/Off m untuk submit form

Il. Menu My Profile

Halaman My Profile akan menampilkan data detail profil kita. Di dalamnya

terdapat informasi personal, riwayat pendidikan, data kompetensi, riwayat

training/seminar/workshop. Ada beberapa hal yang dapat dilakukan pada menu

ini, diantaranya yaitu merubah data profil (data pribadi, riwayat pendidikan,

kompetensi, dan riwayat training/seminar) dan merubah profile picture.

- Untuk merubah data profil, langkah-langkahnya sama seperti yang dijelaskan
pada langkah Merubah Data Profil User di bagian Menu All Users.

- Selanjutnya untuk merubah tampilan profile picture, Langkah-langkahnya
adalah sebagai berikut :

1. Buka dropdown menu Profile Management lalu pilih My Profile

SIAIS UT

# > Dashboa

All Users

My Profile

Gambar 27. Mengakses menu My Profile
2. Pada halaman User Profile Detail, klik menu Action lalu klik tombol Change

Profile Picture
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# ) Profile Management > All Users > Profile Detail

@ User Profile Detail
Trie Afia Farid, S.Kom Action v l u

Stafl

Change Profile Picture

Pamsg Y NIP
N

\ A 4

- P

Golo

First

UNIVERSITAS TERBUKA

Gambar 28. Mengakses menu Change Profile Picture
3. Setelah itu akan muncul pop-up form Upload Profile Picture. Silakan

Browse gambar di computer/laptop Anda untuk merubah profile picture

yang kita inginkan, setelah itu klik tombol Submit . Jika ingin
membatalkan proses merubah profile picture, silakan klik tombol Close

Close

Upload Profile Picture

& Upload Form

File Picture » e
| Browse... | ut-logo.jpg

Close

Gambar 29. Form Upload Profile Picture

4. lJika proses berhasil maka profile picture kita terganti dengan yang baru

Akses Cepat Menu My Profile (Profil Pribadi)

Pada halaman Dashboard terdapat kumpulan shortcut tombol untuk ke beberapa
menu, salah satunya yaitu menu My Profile. Untuk mengaksesnya, pastikan kita
sudah login dan berada pada halaman Dashboard utama. Lalu klik button My

Profile untuk langsung mengakses halaman User Profile Detail (profil pribadi).
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Dashbbard

akses cepat ke menu User Profile Detail

2 (e

My Profile Audit Schedule KDA

RekaD lemen

Manisku

Gambar 30. Akses cepat untuk melihat detail User Profile

3.2.5 Menu Audit Schedule
I. Audit Activity
Pada modul Audit Activity ini, Anda dapat melakukan manajemen kegiatan audit
serta kegiatan monitoring audit.
Melihat List Kegiatan Audit dan Monitoring Audit
1. Untuk dapat melihat seluruh list kegiatan audit maupun monitoring audit,
pastikan Anda sudah terlebih dahulu login ke aplikasi SIAIS. Lalu pada list
menu pilih Audit Schedule lalu pilih Audit Activity
2. Setelah itu akan tampil halaman Activity List yang berisi list-list kegiatan audit
dan monitoring audit
3. Pada halaman ini juga terdapat fitur filter Tahun Audit dan Periode Audit
untuk mempermudah dalam pencarian kegiatan audit atau monitoring audit

pada halaman list kegiatan ini
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# > Audit Schedule > ACTITY List

Activity Lists
BEAEIES

Tahun Audit  All Tahun

Periode Audit  All Periode

Show 10 v entries
ACTIVITY

NO. CODE TYPE TIME

1 ACT2019-0001  Audit Kegiatan Audit Operasional Awal Tahun 2019
UPB.J-UT Bogor

2 ACT2019-0002  Audit Kegiatan Audit Operasional Awal Tahun 2019
UPBJJ-UT Serang

3 ACT2019-0003  Audit Kegiatan Audit Operasional Awal Tahun 2019

UPBJJ-UT Purwokerto

START-END

Mar/17/2019
Mar/23/2019

May/10/2020
May/16/2020

Mar/10/2019
Mar/16/2019

CREATED BY

trie.afia at Jan/11/2019
2027

trie.afia at Jan/11/2019
21.23

trie.afia at Jan/12/2019
10:39

MODIFIED BY

trie.afia at Jan/17/2019
0829

trie.afia at May/06/2021

1712

trie.afia at Jan/12/2019
1050

Gambar 31. Halaman Activity List

Membuat Kegiatan Audit dan Monitoring Audit

Search:

AUDITEE AUDITOR

APPROVAL APPROVAL STATUS

Membuat kegiatan audit hanya dapat dilakukan oleh user dengan role Admin. Jadi,

user dengan role selain Admin tidak dapat mengakses halaman pembuatan

kegiatan audit.

1. Untuk membuat baru kegiatan audit atau monitoring audit, pastikan Anda

telah mengakses halaman Activity List

(+]
2. Kemudian klik tombol untuk memulai membuat kegiatan audit atau

monitoring audit

3. Setelah itu akan tampil halaman form Create Activity. Di dalam form ini kita

bisa membuat kegiatan audit dengan memilih kolom Tipe = Audit, untuk

membuat kegiatan monitoring audit dengan memilih kolom Tipe =

Monitoring

@ 5 Audk Schedule > Acoviy LIst > Greae

Create Activity

Step 1. Activity Form

Periode +
TTD Pengesahan»  Relaor
UPBLJ/UT-Pusat «

Judui Keglatan «

Deskripsi

; |
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Gambar 32. Form Create Activity
4. Kemudian lengkapi kolom-kolom yang wajib diisi, kolom opsional adalah
bersifat boleh diisi boleh juga tidak (kolom yang wajib diisi ditandai dengan
tanda bintang merah * setelah nama label)
5. Setelah seluruh kolom telah diisi, cek kembali dari awal apakah sudah terisi

seluruhnya, agar jika ada kesalahan input bisa langsung diperbaiki, lalu jika

sudah yakin klik tombol Finish atau E

Merubah Data Kegiatan Audit

Merubah data kegiatan audit atau pun monitoring audit hanya dapat dilakukan

oleh user dengan role Admin saja. Untuk merubah data kegiatan audit atau

monitoring audit dapat dilakukan dengan cara berikut:

1. Pertama-tama pastikan kita sudah berada pada halaman Activity List,
kemudian pilih kegiatan audit atau monitoring audit yang ingin kita ubah

datanya. Caranya yaitu dengan klik pada area baris kegiatan audit (sampai

s
berubah warna barisnya menjadi agak gelap) kemudian klik tombol

® © o
View Create On/Off

Tahun Audit 2021 v
Periode Audit Al Periode v
Show 10 v enliies Search:
AcTviTY AUDITEE AUDITOR
NO.  CcODE TYPE TME START-END CREATEDBY MODIFIED BY APPROVAL APPROVAL  STATUS
1 ACT2021-0013  Audit [Tes] Audit Operasional UPB.J-Denpasar Jan/25/2021 vie.afi at Jan/19/2021  trie.afia at Jan/19/2021 | scinve |
Jan/31/2021 0615 06:29 | Aeeroven |
2 ACT2021-0014  Audit Audit Operasional Awal Tahun UPBJJ-UT Tarakan ~ Mar/14/2021 - trie.afia at Feb/16/202]  ayi.karyana at == | aeroven I v |
Mar/20/2021 1801 Mar/09/2021 06:11 3
3 ACT2021-0015 Audit Audit Operasional Awal Tahun UPBJJ-UT Batam  May/09/2021 - trie.afia at Api/12/2021  trie.afia at May/06/2021 3 | scinve |
May/15/2021 1321 2238 3
4 ACT2021-0016 Monitoring Monitoring Tindak Lanjut Hasil Audit UPBJJ-UT  Apr/15/2021 - trie.afia at Api/12/2021  trie.afia at Apr/13/2021 | acve |
Makassar Tahun 2021 Apr/16/2021 1323 214
5  ACT2021-0017 Monitoring Monitoring Tindak Lanjut Hasil Audit UPBJJ-UT  Apr/19/2021 wrie.afia at Api/12/2021  none [ nore | | wor assionen [ v |
Denpasar [Testl Apr/21/2021 1547
6 ACT2021-0018  Audit [Tes] Audit Operasional Medan 1 May/30/2021 tie.afia at May/27/202]  none =3

Gambar 33. Mengakses Menu Edit Activity
2. Seharusnya saat ini kita berada pada halaman form Edit Activity. Pada form
Edit Activity ini silakan melakukan perubahan data pada field-field yang kita

ingin ubah datanya
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Edit Activity
NN

& Approval Information Statita
APPROVAL ROLE TANGGAL REKOMENDAS! ACTIVE
UPBJ-UT Batam

STATUS
AUDITEE 2021-05-09 5/d 2021-05-15 =3
Antonio Vivaldi, S E AUDITOR -sfd- =3
Ahmad Binadi, S € AUDITOR s/d | none |
Baktiar Hertansyah Pohan, S.E. AUDITOR -s/d-  none | KEY VALUE
Created By vie afia
Created Date  2021-04-12 132119

Modified Date  2021-05-06 22.38 09
Kotle Kegiatan ¢ ACT2021-0015

Max. 20 characters length of Kode Kegiatan

Tipe »

Gambar 34. Form Edit Activity

3. Setelah selesai dan yakin akan perubahan datanya, kita klik tombol E

untuk menyimpan datanya secara permanen
4. Terakhir silakan kita lakukan cek pada field-field yang telah kita ubah datanya,

jika berhasil maka data akan berubah sesuai yang kita inginkan

Mengaktifkan Atau Menonaktifkan Kegiatan Audit
Melakukan Aktivasi atau Inaktivasi data kegiatan audit atau pun monitoring audit

hanya dapat dilakukan oleh user dengan role Admin saja. Caranya adalah sebagai

berikut:

1. Pertama-tama pastikan kita sudah berada pada halaman Activity List,
kemudian pilih kegiatan audit atau monitoring audit yang ingin kita ubah

datanya. Caranya yaitu dengan klik pada area baris kegiatan audit (sampai

s
berubah warna barisnya menjadi agak gelap) kemudian klik tombol
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© ’
Create Edit

Tahun Audit | 2021 v
Periode Audit | All Periode v
Show 10 v entries Search:
AcTIVITY AUDITEE AUDITOR
NO. CODE TYPE TITLE START - END CREATED BY MODIFIED BY APPROVAL APPROVAL
1 ACT2021-0013  Audit [Tes] Audit Operasional UPBJJ-Denpasar Jan/25/2021 wrie.afia at Jan/19/2021  twie.afia at Jan/19/2021 | aperoven | | #perovn |
Jan31/2021 o815 0629 | revroven |
2 ACT2021-0014  Audit Audit Operasional Awal Tahun UPBJJ-UT Tarakan  Mar/14/2021 - trie.afia at Fet:/16/2021  ayi karyana at | reeroveo |
Mar/20/2021 1801 Mar/09/2021 0671 [ rone |
REJECTED
3 ACT2021-0015  Audit Audit Operasional Awal Tahun UPBJJ-UT Batam v = ie.afia at Api/12/2021  trie.afi 202 APPROVED | none |
May/15/2021 1321 2238 o |
4 ACTZ021-0016  Monitoring Moritoring Tindak Lanjut Hasil Aucit UPBI-UT  Apr/15/2021 - wie.afia t Api/12/202]  wie.afia at Api/13/2021 ApproVED
Makassar Tahun 2021 Apr/16/2021 1323 2214 ==
5  ACT2021-0017 Monitoring Monitoring Tindak Lanjut Hasil Audit UPBJJ-UT  Apr/19/2021 - wrie.afia a1 Api/12/2021  none [ non |
Denpasar [Test] Apr/21/2021 1547
6  ACT2021-0018  Audit [Tes] Audit Operasional Medan 1 May/30/2021 - trie.afia at May/27/2021  none =

o *»
On/off Monitoring

Gambar 35. Mengakses Menu Aktivasi/Inaktivasi Kegiatan

§
3

STATUS

INACTIVE.

E

&
7

INACTIVE

2. Seharusnya saat ini kita berada pada halaman form Activate/Inactivate

Activity. Pada form ini, jika sebelumnya status kegiatannya adalah Tidak Aktif

(Inactive), maka pesan yang muncul adalah sebuah konfirmasi bahwa kita

akan mela

kukan Aktivasi (Activate) terhadap kegiatan tersebut

# > Audit Schedule > Activity List > Active/Inactive

Activate/Inactivate Activity
B

3 Approval Information

Attention!
You are about to Activate this Audit Activity by clicking “OnlOff button

APPROVAL ROLE TANGGAL REKOMENDASI STATUS
UPBJJ-UT Batam AUDITEE 2021-05-09 s/d 2021-05-15
Antonio Vivaldi, SE. AUDITOR -s/d- =3
Ahmad Binadi, S E AUDITOR -s/d- | nowe |
Baktiar Hertansyah Pohan, S E AUDITOR -s/d- [ non |

3 Primary Information

Kode Kegiatan * ACT2021-0015

Max. 20 characters length of ‘Kode Kegiatan

Gambar 36. Form Aktivasi Kegiatan

3. Sebaliknya, jika status kegiatan saat ini adalah Aktif (Active), maka pesan

yang muncul adalah sebuah konfirmasi bahwa kita akan me-nonaktifkan

(Inactivate) kegiatan tersebut
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# > Audit Schedule > Activity List > Active/Inactive

Activate/Inactivate Activity
BE
Onjoff

£ Approval Information

Attention!
You are about 1o Inactivate this Audit Activity by clicking "OnjOff button
APPROVAL ROLE TANGGAL REKOMENDASI STATUS
UPBJJ-UT Batam AUDITEE 2021-05-09 s/d 2021-05-15
Antonio Vivaldi, S.E. AUDITOR -s/d- [ NONE |
Ahmad Binadi, S.E AUDITOR -s/d- | NONE |
Baktiar Hertansyah Pohan, S.E AUDITOR -s/d- | NONE |

8 Primary Information

Kode Kegiatan * ACT2021-0015

Max. 20 characters length of ‘Kode Kegiatan

Gambar 37. Form Inaktivasi Kegiatan

V]
4. Setelah yakin kita klik tombol untuk submit proses Aktivasi/Inaktivasi

kegiatan

Export Surat Penugasan (PDF)

Melakukan export surat penugasan kegiatan audit atau pun monitoring audit

hanya dapat dilakukan oleh user dengan role Admin saja. Caranya adalah sebagai

berikut:

1. Pertama-tama pastikan kita sudah berada pada halaman Activity List,
kemudian pilih kegiatan audit atau monitoring audit yang ingin kita lihat

detailnya. Caranya yaitu dengan klik pada area baris kegiatan audit (sampai

@
berubah warna barisnya menjadi agak gelap) kemudian klik tombol
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Edit On/Off

Tahun Audit | 2021 v
Periode Audit | All Periode v
Show 10 v entries Search
ACTIVITY AUDITEE AUDITOR
NO. CODE TYPE TITLE START - END CREATED BY MODIFIED BY APPROVAL APPROVAL STATUS
1 ACT2021-0013  Audit [Tes] Audit Operasional UPBJJ-Denpasar Jan/25/2021 - trie.afia at Jan/19/2021  trie.afia at Jan/19/2021
Jan/31/2021 0615 0629 =
2 ACT2021-0014  Audit Audit Operasional Awal Tahun UPBJJ-UT Tarakan ~ Mar/14/2021 - trie.afia at Feb/16/2021  ayi karyana at | reerove |
Mar/20/2021 1201 Mar/09/2021 06:11 [ rone |
3 ACT2021-0015 Audit Audit Operasional Awal Tahun UPBJJ-UT Batam  May/09/2021 - trie.afia at Api/12/202]  trie.afia at May/06/2021 =3
May/15/2021 1221 2238  none |
4 ACT2021-0016 Monitoring Monitoring Tindak Lanjut Hasil Audit UPBJJ-UT  Apr/15/2021 - trie.afia a1 Api/12/202]  trie.afia a1 Api/13/202] | aeeroven | | Approven |
Makassar Tahun 2021 Apr/16/2021 1323 2214 | Aeproven |
5 ACT2021-0017 Monitoring Monitoring Tindak Lanjut Hasil Audit UPBJJ-UT  Api/19/2021 trie.afia a1 Api/12/202]  none | wone | ot assionen [ nacTive
Denpasar [Test] Apt/21/2021 1547
6 ACT2021-0018  Audit [Tes] Audit Operasional Medan 1 May/30/2021 trie.afia a1 May/27/2021  none [ none |

Gambar 38. Akses menu Activity Detail dari Activity List

2. Seharusnya saat ini kita berada pada halaman Activity Detail. Kemudian klik

D

Surat Penugasan

tombol untuk melakukan preview surat penugasan

# 5 Aude Schedule > Actvity List 5 Detail

Activity Detall

& Approval Information Status

A E

APPROVAL ROLE TANGGAL REKOMENDAS!

UPBJJ-UT Batam AUDITEE 2021-05-09 5/d 2021-05-15

Antonio Vivalds, S E. AUDITOR s/
Ahmad Binadi, § £ AUDITOR -s/d-

Bakuar Hertansyah Pohan, § £ AUDITOR -8/~ KEY VALUE

Created By trie afia

Created Date  2021-04-121321.19

88 oo oo Mndifiad B i ot

Gambar 39. Halaman Activity Detail (akses halaman Preview Surat Penugasan)

3. Llalu pada halaman Preview Surat Penugasan klik tombol E untuk

meng-export surat penugasan ke format file PDF

# 5 Audit Schedule > Activity List > Detail > Surat Penugasan

Preview Surat Penugasan

KEMENTERIAN PENDIDIKAN DAN KEBUDAYAAN

A
A—— ——— -
1 UNIVERSITAS TERBUKA
b Jalan Cabe Raya. Pondok Cabe, Pamulang, Tangerang Selatan 15418
Eﬁ Telepon: 021-7490941 (Hunting)
Faksimile: 021-7490147 (Bagian Unum), 021-7434290 (Sckretaris Rektor)
Laman: www.ut.ac.id

SURAT TUGAS
NOMOR: /UN31.65/WS/2021

Rektor Universitas Terbuka menugaskan kepada Pegawai Universitas Terbuka di bawah ini:

Gambar 40. Export Surat Penugasan ke format PDF
4. Setelah itu akan tampil halaman tampilan PDF Surat Penugasan. Silakan Print

langsung atau Download file-nya dalam format PDF.
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UNIVERSITAS TERBUKA
SATUAN PENGAWAS INTERNAL

r
Al

2A Alamat : Jatan Cabe Raya, Pondok Cabe, Pamuang, Tangerang Seéatan, 15418
S Tolp. 0217490041, Fax, 0217490147
SURAT TUGAS
NOMOR: /UN31.65/WS/2021

Reklor Universitas Terbuka menugaskan kepada Pegawai Universitas Terbuka di bawah ini:

No. Nama NIP Pangkat/ Unit Kerja Tugas
Golongan Dalam Tim

1. |ors. Yun tswanto, M.Si SPI - Satuan Pengendal
Pengawas Internal | Teknis

2. |Antonio Vivaldi, SE. 123456789101112TKTO01 [llla SPI- Satuan Ketua
Pengawas Internal

3 ‘Ahmad Binadi, S.E. 112233445566AGT01 SPI - Satuan Anggota
Pongawas Internal

4 Baktiar Hertansyah Pohan, |123456789101112TKT01 |liie SPI - Satuan Anggota
SE z Pengawas Internal

Untuk melaksanakan Audit Operasional Awal Tahun UPBJJ-UT Batam dengan fincian lugas sebagai berkut.
1. Tanggal 02 - 07 Mei 2021 Pre Audi (6 hari)

a. Menyusun Program Kerja Audit
b. Menyusun Kertas Kerja Audit
. Menetapkan kebutuhan data yang relevan

Gambar 41. Halaman Export PDF Surat Penugasan

Approval Kegiatan (Audit/Monitoring)

Approval kegiatan audit atau monitoring audit bisa dilakukan oleh user dengan
role Auditor dan Auditee. Untuk tahapan melakukan proses Approval kegiatan
audit atau monitoring audit adalah sebagai berikut:

1. Pertama-tama pastikan kita sudah berada pada halaman Activity List,
kemudian pilih kegiatan audit atau monitoring audit yang ingin kita approve.
Caranya yaitu dengan klik pada area baris kegiatan audit (sampai berubah

&

warna barisnya menjadi agak gelap) kemudian klik tombol SR

# > Audit Schedule » Activity List > Approve

Act|V|ty Approval

8 Summary Information

TYPE TITLE START-END
AUDIT [Tes] Audit Operasional Medan 1 30 Mei 2021 s/d 05 Juni 2021
Approved By upbjj.medan
Approved Date * Now.

Response * * Approve Reject

Gambar 42. Halaman Approval Kegiatan
2. Untuk melakukan proses Approve, silakan melakukan pilihan "Approve’ pada

field input Response

Buku Petunjuk Penggunaan Aplikasi Hal 38 dari 106
SISTEM INFORMASI AUDIT INTERNAL SPI



# > Audit Schedule » Activity List » Approve

Act|V|ty Approval

% Summary Information

TYPE TITLE START-END
AUDIT [Tes] Audit Operasional Medan 1 A0 Mei20211s/d.05 Jni2021
& Approval Response
Approved By * upbjj.medan
Approved Date * Now.
Response * Approve  (® Reject
Suggest Start Date * 2021-05-30
Suggest End Date * 2021-06-05

Gambar 43. Halaman Approval Kegiatan (pilihan Reject)
3. Untuk melakukan proses Reject, silakan melakukan pilihan "Reject’ pada field
input Response kemudian khusus role Auditee bisa melakukan input saran

tanggal audit yang diinginkan (suggest start dan end date)

4. Lalu jika sudah yakin klik tombol E untuk menyimpan data approval-nya

Gambar 44. Kolom Auditee Approval pada Activity Lists

5. Cek kembali pada halaman Activity Lists, jika proses Approval berhasil maka
pada kolom “Auditee Approval® akan berubah statusnya sesuai dengan yang

kita pilih (Approved atau Rejected)

Verifikasi Monitoring Audit
Untuk proses verifikasi temuan dari kegiatan monitoring audit dapat dilakukan
oleh auditor dari kegiatan tersebut. Untuk tahapan melakukan proses verifikasi
temuan dari kegiatan monitoring audit adalah sebagai berikut:
1. Pertama-tama pastikan Anda telah mengakses halaman “Activity Lists’, untuk
tahapannya bisa melihat bagian *‘Melihat List Kegiatan Audit dan Monitoring
Audit’
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Activity Lists
EEEeE

Tahun Audit | 2021 v
Show 10 v entries Search
Actviy AUDITEE AUDITOR
NO.  coDE TYPE T START-END CREATEDBY MODIFIEDBY APPROVAL APPROVAL  STATUS
| ACI2021-0013 Aubt  [ies] Audi Operasional UPBJJ-Denpasar sanv2sr2021 i ] [rmoveo]
Jan/31/2021 0615 0629 | arenovon |
2 ACT2021-0015  Audit Audit Operasional Awal Tahun UPBJJ-UT Batam  May/09/2021 e afia a1 Apr/12/202]  trie.afia at Jul/20/2021 == | ione |
May/15/2021 1321 1549 o |
3 ACT2021-0017 Monitoring Manitoring Tindak Lanjut Hasil Audit UPBL-UT  Apr/19/2021 - wie.afia at Apr/12/202]  trie.afia at Jul/20/2021 | e |
Denpasan [Tesi] Apri21/2021 1547 1619
4 ACTZ21-0020 Audt  Kegistan Audit Operasional Akhir Tshun UPBJJ-  Aug/15/2021 vieafia ar Ju29/2021  trie.afin ot Auvgowzozt |
UT Surakarta Augs21/2021 1239 1725 non
5 ACT2021-0022 Monitoring Monitoring Kegiatan Audit Operasional UPBJJ-UT ~ Aug/25/2021 wie.afia 51 Aug/18/2021  trie.afia a1 Aug/20/2021 REIECTED | aeerove | | ncrive]
Makassar Aug/28/2021 2343 0810 =3
Showing 110 5 of s enies m

Gambar 45. Mengakses halaman View Monitoring dari halaman Activity Lists
2. Selanjutnya pilih kegiatan monitoring audit yang ingin kita verifikasi. Caranya
yaitu dengan klik pada area baris kegiatan audit (sampai berubah warna

+

View Monitoring
untuk

barisnya menjadi agak gelap) kemudian klik tombol
menuju halaman View Monitoring dan melihat temuan-temuan yang ada

pada kegiatan tersebut

Code: KDA-10

Auditor. Abmad Binadi, S £
i UPBS-UT Makassar

Gambar 46. View Monitoring berisi temuan-temuan dengan status Open
3. Pada halaman View Monitoring terdapat temuan-temuan yang berstatus
OPEN. Silakan pilih satu temuan yang akan Anda verifikasi lalu klik tombol

Action > Verify

# Monoing Al » Kenas Diata Auc (KEK) 5 View » Veriy

Verifikasi Tindak Lanjut KDA

& Summary KDA

KDAINDEX ASPEK AUDIT KODE TEMUAN KRITERIA AKARPENVEBAB AKIBAT TOL PENYELESMIAN

wou1a mm pr—n st war s 27 gqustas 2020 Ex

KODETINDAKLANAIT  OLEW TGL TINDAK LANAUT  DESKRIPS! STATUS VERIFIKAS|  VERIFIKASINOTES

KT8 Ketua UPBLI-UT Makassar 28 Aqustus 2020 terlmee dokumen tindsk anjt untk KDA-10 i, terima ki [

81 Summary Dokumen Tindak Lanjut

2020-68-28 200406

2020-08-28 200407

Gambar 47. Halaman Verifikasi Tindak Lanjut KDA
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4. Saat ini Anda berada di halaman Verifikasi Tindak Lanjut KDA, silakan cek
ringkasan info KDA (Summary KDA), dokumen tindak lanjut, kemudian
masukkan Deskripsi Verifikasi jika ada, dan pilih status Open / Close (Close

untuk menutup temuan tersebut). Setelah yakin dengan isian Anda, klik

tombo|

5. lJika proses verifikasi berhasil akan muncul pesan:
@ Verification Process Successful

Gambar 48. Pesan berhasil verifikasi temuan (dari monitoring audit)

Il. Other Activity (Kegiatan Lain)
Halaman ini dibuat khusus hanya bisa diakses oleh role Admin aplikasi SIAIS.
Modul ini memungkinkan Admin SIAIS untuk membuat tanggal-tanggal hari libur
nasional ataupun tanggal-tanggal tertentu seperti event internal UT ataupun event
khusus lainnya.
Fungsinya adalah ketika proses pembuatan jadwal kegiatan audit, tanggal-tanggal
yang sudah diinputkan disini menjadi filter bantuan untuk Admin agar lebih mudah

menentukan tanggal kegiatan audit.

Melihat List Kegiatan Lain
Untuk halaman Other Activity Lists hanya dapat diakses oleh role Admin dari
aplikasi SIAIS. Tahapannya adalah sebagai berikut:
1. Pertama-tama pastikan Anda sudah login terlebih dahulu ke aplikasi SIAIS
menggunakan Username dan Password Anda masing-masing.
2. Selanjutnya akses menu Other Activity dari menu navigasi di sebelah kiri

halaman, letaknya ada di dalam menu Audit Schedule

Audit Activity

| Other Activity I

Gambar 49. Mengakses menu Other Activity

3. Saat ini Anda berada pada halaman Other Activity Lists yang berisi list
kegiatan lain yang sudah berhasil dibuat beserta informasi Statusnya (Active

atau Inactive)
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# 5 Audn Schedule 3 Crher Activity

Other Activity Lists
BEEAE

Show 10 v entries

Search
NO. ACTIVITY CODE DATES) staTUs
1 ISAMNEWVEARZOIE 80911 =a
2 w8120 =a
3 81224 e
A W8-12:25 =
s Newviamors 2019-01-01,2018-12-31 =
6 CHINESENYEAR2DIS 2190205 =3
NYEPI2019 90307 [ |
8 ISRAMIAAJZOIS 2019-01-03 [cine
9 eascaizois 2019-0119,2019-04-21 =a
10 HBURHZ!S 20190501
Stoing 1107100t 24 eries W e

Gambar 50. Halaman Other Activity Lists

Membuat Kegiatan Lain
Untuk halaman Create Other Activity hanya dapat diakses oleh role Admin dari
aplikasi SIAIS. Tahapannya adalah sebagai berikut:

1. Pertama-tama pastikan Anda sudah mengakses halaman Other Activity Lists.

Tahapannya ada di sub-bagian sebelum tahapan ‘Membuat Kegiatan Lain

©
ini, lalu setelah itu pilih tombol untuk mulai membuat kegiatan lain

Search
NO. ACTIVITY CODE CATEGORY oATES) stATUS
1 ISLMNOWVEATZ01 e Lt Nasional a1 ==
z Aoz Ml N Munammad SAW Han Liur Nasionsl Wis-11-m [ acone |
3 CBNATAL20IS 1 Bersama Han Raya Natal Han Libur Nasional Wg-12.24 [cine |
s NaTAZOIS Har 12018 e 1225 [ |
5 20190100, 2018-12-31 [ |
6 a015-02-05 ==
0 ' o
8 o]
9 PASKAH2019 2019 04 19,2019-04 21 =
10 HRURUH2019 i Hari | it al 2019-05-01 | Acrve |

Gambar 51. Mengakses halaman Create Other Activity

2. Pada halaman Create Other Activity, silakan input field Activity Code
(disesuaikan dengan nama event/kegiatannya), Title (judul event/kegiatan),
Description (deskripsi — opsional), Category (kategori event/kegiatan), dan

Date(s) (tanggal event/kegiatan — bisa dipilih beberapa tanggal). Jika sudah

yakin dengan isian fieldnya klik tombol E untuk menyimpan hasilnya
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# > Audit Schedule > Other Activity > Create

E]‘réa:"twe Other Activity

~
z
B Heset m
4 Detail Information

Activity Code +
Max. 20 characters length of Activity Code
Title *
Description
Vi
Category * Hari Libur Nasional v
Date * Activity Date(s

Gambar 52. Form untuk membuat kegiatan lain (Other Activity)
3. Setelah itu cek pada halaman Other Activity Lists untuk data kegiatan kita

yang telah berhasil dibuat

Melihat Detail Kegiatan Lain

Untuk halaman Other Activity Detail hanya dapat diakses oleh role Admin dari
aplikasi SIAIS. Tahapannya adalah sebagai berikut:

1. Pertama-tama pastikan Anda sudah mengakses halaman Other Activity Lists.

Tahapannya ada di sub-bagian "Melihat List Kegiatan Lain’

# > Audit Schedule > Other Activty

Otheyr Activity Lists
BEEaEE

Show 10 v entries

Search
NO. ACTIVITY CODE Tme CATEGORY DATE(S) sTaTUs
1 ISLAMNEWYEARZOTS  Tahun Banu Isiom Hor Libus Nasional 8091
2 mAuLo2018 Maulid Nabi Muharmmad SAW Hari Libur Nasional 081120 =a
3 canaTALZOIg Curi Bersam H Raya Ntel Han Libur Nasional 081224 [acine ]
& wamoma Ve ey Natal 2016 Han Lbur Nasioasl 08-12-25
5 NEwvEAR2019 Libur Tohun Baru Masthi 2019 Hari Libur Nasional 2019-01-01,2018-12-31 =3
6 CHINESENYEAR2019 Tahun Baru Cina Hari Libur Nasional 2019-02-05 | scrve |
1 Nveprol Han Ry Nyept Han Libur Nasion: 190307 =3
8 ISRAMIRAZ0IS [Ty R—r—— Hant 190403
9 PASKAH2019 Hari Raya Paskah & Sunday Hari Libur Nasional 2019-04-19,2019.04 21
10 HBURUH2019 Han Buruh Intemasional Han Libur Nasional 2019-05-01 | acinv: |
Showing 11010 of 24 entres Bl: : e s

Gambar 53. Halaman Other Activity List (menuju menu view detail)

2. Setelah itu pilih kegiatan yang akan Anda lihat detailnya dengan klik pada area

@
baris kegiatan tersebut, lalu pilih tombol
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Gambar 54. Halaman Other Activity Detail

# > Audit Schedule > Other Activity > Detail
Eg AUDIT SCHEDULE
o
Back
8 Detail Information
Activity Code NEWYEAR2019
Max. 20 characters length of Activity Code
Title + Libur Tahun Baru Masehi 2019
Description Activity Description (Optional
Y
Category *
Date « @ JANUARY 2019 o]
su MO T WE TH FR SA

3. Setelah itu akan muncul halaman Other Activity Detail yang berisi detail

informasi kegiatan yang dipilih

Mengubah Data Kegiatan Lain

Untuk mengubah data kegiatan lain hanya bisa dilakukan oleh role Admin. Berikut

tahapannya:

1. Pertama-tama pastikan Anda sudah mengakses halaman Other Activity Lists.

Tahapannya ada di sub-bagian "Melihat List Kegiatan Lain’

Other Activity Lists

HEHE
Create Edin on/off
Show 10 entries Searcn
NO. ACTIVITY CODE Tme CATEGORY oaTElS) staTUs
ISLAMNCWYEARZO18 230511 =
MAIDz018 e [ |
caNATAIZ018 81724
PRI PN w1225
L HariLeurNasionsl  2019.01.01,201812.31
6 CHINESENVEARZDIO Tatun Baru Cina HanLibur Nasions 19-02.05 [z |
NYEpizOIS Hari Haya Nyeps Hari Lur Nasions! T
IsANIATZ01S Nt Han wis-on03 [icone |
5 maskumors 2015-04-19,2019-04-21
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Gambar 55. Mengakses halaman Edit Other Activity

2. Setelah itu pilih kegiatan yang akan Anda ubah datanya dengan klik pada area

Vg
baris kegiatan tersebut, lalu pilih tombol untuk mulai merubah
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B4 Detail Information

Activity Code « NEWYEAR2019
Max. 20 characrers length of Activity Code
Title * Libur Tahun Baru Masehi 2019
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Y
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Gambar 56. Form Edit Other Activity
3. Pada halaman Edit Other Activity silakan ubah field yang perlu diubah,

setelah yakin dengan perubahannya klik tombol E untuk menyimpan

perubahan

Mengaktifkan/Menonaktifkan Data Kegiatan Lain

Untuk menghapus data kegiatan lain hanya bisa dilakukan oleh role Admin saja.
Tahapannya sebagai berikut:

1. Pertama-tama pastikan Anda sudah mengakses halaman Other Activity Lists.

Tahapannya ada di sub-bagian "Melihat List Kegiatan Lain’

# ) AudicSchedute > Orhes Actity

Other Activity Lists
A A e

Show 10 v entries

Search
NO. ACTIVITY CODE Tme CATEGORY DATES) STATUS
1 ISMNEWYEARZOIE  TohunB: 280911
2 mAULID20I 2181120
3 conaraoma m1224 =3
NATAL2018 Hari Raya Nanal 2018 2181225

s Newveanoig Libur T Baru Maseh 2019 219-01-01, 2018-12:31 =a
6 CHNESENVEAROTIS 2190205
NYEPIZOI9 [ccin |

0 isnAMmAz0I9 =a
u o v |

e | B

Gambar 57. Mengakses halaman Activate/Inactivate Other Activity

2. Setelah itu pilih kegiatan yang akan Anda non-aktifkan dengan klik pada area

o
baris kegiatan tersebut, lalu pilih tombol untuk menuju ke halaman
Activate/Inactivate Other Activity
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3. Pada halaman Activate/Inactivate Other Activity silakan cek kembali pesan

konfirmasi di bagian paling atas form

# ) Audit Schedule > Other Activity > Activate/Inactivate

Activate/Inactivate Other Activity

(0]
Onjoff
£3 Detail Information

Autention!
You are about to Inactivate this Activity by clicking “OnJOff button

Activity Code * NEWYEAR2019
Max. 20 characters length of Activity Code
Title =

Libur Tahun Baru Masehi 2019

Description Activity Description (Optional

Category

Gambar 58. Form Activate/Inactivate Other Activity

4. Untuk menonaktifkan kegiatan, pesannya akan tertulis seperti berikut ini:

Attention!

You are about to Inactivate this Activity by clicking "On]Off” button

Gambar 59. Pesan konfirmasi proses inaktivasi kegiatan

5. Untuk mengaktifkan kegiatan, pesannya akan tertulis seperti berikut ini:

Attention!
You are about to Activate this Activity by clicking "On]Off” button
Gambar 60. Pesan konfirmasi proses aktivasi kegiatan

(0]

On/Off

6. Setelah yakin klik tombol untuk memulai proses aktivasi atau

inaktivasi

3.2.6 Menu Kinerja
I.  Penilaian Ketua
Penilaian dari Ketua Tim Auditor kepada masing-masing anggota tim auditor yang
bertugas ke UPBJJ/Unit terkait. Halaman ini hanya bisa diakses oleh Ketua Tim

Auditor dari masing-masing kegiatan audit. Berikut tahapan untuk melakukan

penilaiannya:
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1. Pertama-tama akses halaman Penilaian Ketua melalui menu navigasi Kinerja

> Penilaian Ketua

Penilaian Ketua

Penilaian Dalnis

Penilaian Auditee

Gambar 61. Mengakses halaman Penilaian Ketua

2. Setelah itu pilih kegiatan audit yang akan dinilai dengan klik pada area baris
kegiatan audit (sampai warna baris kelihatan agak gelap), lalu klik tombol

Creat . ar .
@ untuk mulai melakukan penilaian

@ Penilaian Ketua

Gambar 62. Halaman Penilaian Ketua (memilih kegiatan audit)
3. Pada halaman Create Penilaian Ketua terdapat list-list auditor yang bertugas,

silakan pilih salah satu auditor lalu klik tombol Action > Mulai Menilai

Gambar 63. Mengakses form Penilaian Ketua Tim Terhadap Anggota

4. Saat ini Anda sudah bisa melakukan penilaian terhadap anggota auditor yang
bertugas. Di halaman ini terdapat informasi nama anggota yang dinilai,
UPBJJ/Unit tempat auditor tersebut bertugas, dan jadwal kegiatan audit.
Silakan isikan nilai masing-masing kriteria pada kolom Nilai dengan skala 1 s/d
5 (Sangat Kurang s/d Sangat Baik) dan isikan komentar Anda sebagai Ketua

Tim Auditor pada kolom Komentar (opsional)
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Penilaian Ketua Tim Terhadap Anggota

Anggota: Baktiar Hertansyah Pohan, S.E. ~
Unit/UPBJJ: UPBJJ-UT Denpasar
Waktu Audit: 25 Januari 2021 s/d 31 Januari 2021
Catatan:
« Berilah penilaian Bapak/Ibu pada kolom yang sudah tersedia, sesuai dengan kondisi auditor yang bersangkutan.

« Kriteria Penilaian: 1 = Sangat Kurang, 2 = Kurang, 3 = Sedang, 4 = Baik, 5 = Sangat Baik

NO. KRITERIA NILAI

1 Perencanaan Audit

a. Apakah anggota tim berkontribusi aktif dalam penyusunan PKA?

b. Apakah anggota Tim memahami tujuan dari PKA?

Gambar 64. Form Penilaian Ketua Tim Terhadap Anggota

5. Setelah yakin dengan nilai yang Anda input, klik tombol untuk hanya

menyimpan data penilaian atau tombol untuk menyimpan dan

mengirim data ke auditor yang bersangkutan

Il.  Penilaian Dalnis
Penilaian dari Pengendali Teknis (Dalnis) kepada Ketua Tim Auditor yang bertugas
ke UPBIJJ/Unit terkait. Halaman ini hanya bisa diakses oleh Dalnis dari masing-
masing kegiatan audit. Berikut tahapan untuk melakukan penilaiannya:
1. Pertama-tama akses halaman Penilaian Dalnis melalui menu navigasi Kinerja

> Penilaian Dalnis

Penilaian Ketua

| Penilaian Daln|sj

Penilaian Auditee

Gambar 65. Mengakses halaman Penilaian Dalnis

2. Setelah itu pilih kegiatan audit yang akan dinilai dengan klik pada area baris

kegiatan audit (sampai warna baris kelihatan agak gelap), lalu klik tombol

©
Create . e
- untuk mulai melakukan penilaian
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Gambar 66. Halaman Penilaian Dalnis (memilih kegiatan audit)
3. Pada halaman Create Penilaian Dalnis terdapat 1 (satu) Ketua Tim Auditor

yang bertugas, silakan pilih lalu klik tombol Action > Mulai Menilai

# > Kinerja > Penilaian Dalnis » Assess

@ Buat Penilaian Dalnis

Role: Leader Action ~

Ketua Tim: Ahmad Binadi, S_E.

Work Unit: SPI - Satuan Pengawas Internal
UPBJJ: UPBJJ-UT Surakarta
Status: 17

Gambar 67. Mengakses form Penilaian Dalnis Terhadap Ketua Tim
4. Saat ini Anda sudah bisa melakukan penilaian terhadap ketua tim auditor
yang bertugas. Di halaman ini terdapat informasi nama ketua tim yang dinilai,
UPBJJ/Unit tempat auditor tersebut bertugas, dan jadwal kegiatan audit.
Silakan isikan nilai masing-masing kriteria pada kolom Nilai dengan skala 1 s/d
5 (Sangat Kurang s/d Sangat Baik) dan isikan komentar Anda sebagai Dalnis
pada kolom Komentar (opsional)

Penilaian Dalnis Terhadap Ketua Tim
Ketua Tim: Ahmad Binadi, S_E. A

Unit/UPBJJ: UPBJJ-UT Surakarta
Waktu Audit: 15 Agustus 2021 s/d 21 Agustus 2021
Catatan:
« Berilah penilaian Bapak/lbu pada kolom yang sudah tersedia, sesuai dengan kondisi auditor yang bersangkutan.

« Kriteria Penilaian: T = Sangat Kurang, 2 = Kurang, 3 = Sedang, 4 = Baik, 5 = Sangat Baik

NO. KRITERIA NILAI

1 Perencanaan Audit
a. Apakah Ketua Tim memahami permasalahan yang dituangkan dalam PKA? 0 ~
b. Apakah Ketua Tim memahami tujuan dari PKA? 0 A

v

Close © Submit

Gambar 68. Form Penilaian Dalnis Terhadap Ketua Tim Auditor
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5. Setelah yakin dengan nilai yang Anda input, klik tombol untuk hanya

menyimpan data penilaian atau tombol untuk menyimpan dan

mengirim data ke auditor yang bersangkutan

lll.  Penilaian Auditee
Penilaian dari Auditee (UPBJJ/Unit) kepada Tim Auditor yang bertugas ke
UPBJJ/Unit terkait. Halaman ini hanya bisa diakses oleh Auditee dari masing-
masing kegiatan audit. Berikut tahapan untuk melakukan penilaiannya:
1. Pertama-tama akses halaman Penilaian Auditee melalui menu navigasi

Kinerja > Penilaian Auditee

Penilaian Ketua

Penilaian Dalnis

Penilaian Auditee

Gambar 69. Mengakses halaman Penilaian Auditee
2. Setelah itu pilih kegiatan audit yang akan dinilai dengan klik pada area baris

kegiatan audit (sampai warna baris kelihatan agak gelap), lalu klik tombol

©
Create . a1 s
- untuk mulai melakukan penilaian

@ Penilaian Auditee

Gambar 70. Halaman Penilaian Auditee (memilih kegiatan audit)
3. Pada halaman Create Penilaian Auditee terdapat 1 (satu) data Tim Auditor

yang bertugas, silakan pilih lalu klik tombol Action > Mulai Menilai
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# > Kinerja > Penilaian Auditee » Assess

@ Buat Penilaian Auditee

Tim Auditor Action v

Auditor: Mulai Menilai

1. Ahmad Binadi, S E.

2 Riyas Hayu Agrista, S.E.

3. Bahir Mukhammad
UPBJJ: UPBJJ-UT Surakarta

staws: [E3

Gambar 71. Mengakses form Penilaian Auditee Terhadap Tim Auditor
4. Saat ini Anda sudah bisa melakukan penilaian terhadap tim auditor yang
bertugas. Di halaman ini terdapat informasi nama setiap anggota tim yang
bertugas (termasuk ketua tim), UPBJJ/Unit tempat auditor tersebut bertugas,
dan jadwal kegiatan audit. Silakan isikan nilai masing-masing kriteria pada
kolom Nilai dengan skala 1 s/d 5 (Sangat Kurang s/d Sangat Baik) dan isikan
komentar Anda sebagai Auditee pada kolom Komentar (opsional)

Penilaian Auditee

Auditor:
1. Ahmad Binadi, S.E.
2. Riyas Hayu Agrista, S E.
3. Bahir Mukhammad
Unit/UPBJJ: UPBJJ-UT Surakarta
Waktu Audit: 15 Agustus 2021 s/d 21 Agustus 2021
Catatan:

« Berilah penilaian Bapak/ibu pada kolom yang sudah tersedia, sesuai dengan kondisi tim auditor yang bersangkutan.

« Kriteria Penilaian: 1 = Sangat Kurang, 2 = Kurang, 3 = Sedang, 4 = Baik, 5 = Sangat Baik

NO. KRITERIA NILAI
1 Pembukaan Audit

a. Apakah penjelasan Tim Auditor temtang tujuan pelaksanaan audit mudah dipahami? 0 = J

Close © Submit

Gambar 72. Form Penilaian Auditee Terhadap Tim Auditor
5. Setelah yakin dengan nilai yang Anda input, klik tombol untuk hanya

menyimpan data penilaian atau tombol untuk menyimpan dan

menampilkan data ke auditor terkait

3.2.7 Menu Program Kerja Audit
I.  Melihat List Program Kerja Audit

Halaman list program kerja audit hanya dapat diakses oleh masing-masing auditor

yang bertugas (termasuk ketua). Halaman ini berisi seluruh program kerja audit
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yang telah dibuat. Untuk mengakses ke halaman ini caranya adalah sebagai
berikut:
1. Pertama-tama kita harus mengakses menu List PKA pada menu navigasi, yaitu

dengan klik pada menu Program Kerja Audit > List PKA

List PKA

Gambar 73. Menu navigasi ke halaman List PKA

2. Selanjutnya pada halaman list kegiatan audit, pilih kegiatan audit yang akan

kita lihat data PKA-nya dengan klik pada area baris kegiatan audit (sampai

@
warna baris kelihatan agak gelap), lalu klik tombol (Anda bisa
menggunakan filter Tahun Audit untuk menyeleksi kegiatan audit

berdasarkan tahun auditnya)

Search

NO.  ACTIVITY CODE Tme upBy) ACTIVITY DATE TOTALPKA  NOTREVIEWED/REVIEWED

Gambar 74. Mengakses halaman List PKA lewat halaman list kegiatan audit
3. Saat ini Anda berada pada halaman List PKA yang berisi data-data PKA dari
kegiatan audit yang Anda pilih

Gambar 75. Halaman List PKA

Il.  Melihat Detail Program Kerja Audit
Halaman detail program kerja audit hanya dapat diakses oleh masing-masing

auditor yang bertugas (termasuk ketua). Halaman ini berisi data detail dari PKA
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yang Anda pilih. Untuk dapat mengakses halaman ini caranya adalah sebagai

berikut:

1. Pertama-tama pastikan Anda telah berhasil mengakses halaman List PKA.

Langkah-langkahnya ada di bagian I. Melihat List Program Kerja Audit

Code: PKA-1 Action ~

Disusun Oleh: Tim Audit UPBJJ-UT Surl View I
Unit Kerja: UPBJJ-UT Surakarta Edit

Judul: PKA Keuangan

starus: [IETE Delete

Review

Gambar 76. Mengakses halaman detail PKA
2. Setelah Anda berada di halaman List PKA, untuk melihat detail program kerja
audit silakan pilih PKA yang akan Anda lihat detailnya, lalu klik Action > View

PKA Detail

UNIVERSITAS TERBUKA
o SATUAN PENGAWAS INTERNAL

S B ALAMAT : JALAN CABE RAYA, PONDOK CABE, PAMULANG, TANGERANG SELATAN, 15418

TELP.021-7490941, FAX 021- 7450147

PROGRAM KERJA AUDIT (PKA)
KEUANGAN
Unit Kerja : UPBL-UT Surakara
Disusun Direview
Oleh : Tim Audit UPBJJ-UT Surakarta Oleh

Tanggal - 0B Agustus 2021 Tanogal

Terdapat selisih Jumlsh nominal uang kas di brankas (hasil cash counr) dengan saldo akhir yang tercatat di Pembukuan (Buku Kas

Tunai)

Untuk meyakinkan bahwa jumlah uang kas yang ada di brankas sama dengan saldo akhir yang tercatat di Buku Kas Tunai (BKT). Jika
uang yang berada di brankas lebih besar daripada di saldo Buku Kas Tunai (BKT), Pastikan UPBJJ-UT Serang mengetahui peruntukan

@ Download ~ Close

Gambar 77. Halaman Detail Program Kerja Audit

v

3. Setelah itu akan muncul pop-up halaman PKA Detail yang berisi data detail

program kerja audit yang Anda pilih

UNIVERSITAS TERBUKA
SATUAN PENGAWAS INTERNAL pKAA

Alamat : Jalan Cabe Raya, Pondok Cabe, Pamulang, Tangerang Selatan, 15418
Telp. 021-7490941, Fax. 021-7490147

PROGRAM KERJA AUDIT (PKA)

KEUANGAN
Unit Kerja : UPBJJ-UT Surakarta
Disusun Direview
Oleh : Tim Auditor UPBJJ-UT Surakarta Oleh :
Tanggal : 08 Agustus 2021 Tanggal :
Paraf : Paraf :

Tentative Audit Objective (TAQ)

Terdapat selisih Jumlah nominal uang kas di brankas (hasil cash count) dengan saldo
akhir yang tercatat di Pembukuan (Buku Kas Tunai)

Tujuan Audit
Untuk meyakinkan bahwa jumlah uang kas yang ada di brankas sama dengan saldo
akhir yang tercatat di Buku Kas Tunai (BKT). Jika uang yang berada di brankas lebih
besar daripada di saldo Buku Kas Tunai (BKT), Pastikan UPBJJ-UT Serang
mengetahui peruntukan penggunaan uang tersebut.

Langkah-langkah Kerja

No. Uraian Langkah-langkah Kerja

No. Auditor

KKA

Realis
asi

Alokas
i

Gambar 78. Tampilan halaman view PDF Program Kerja Audit
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4. Di halaman ini Anda dapat mengunduh file detail PKA dalam bentuk PDF
dengan klik pada tombol Download > PDF

lll.  Membuat Program Kerja Audit
Halaman membuat program kerja audit hanya dapat diakses oleh masing-masing
auditor yang bertugas (termasuk ketua). Untuk dapat mengakses halaman ini
caranya adalah sebagai berikut:
1. Pertama-tama pastikan Anda telah berhasil mengakses halaman List PKA.

Langkah-langkahnya ada di bagian I. Melihat List Program Kerja Audit

TLLI-UT Surskara

PKA Bahan Ajar

Gambar 79. Mengakses halaman Create PKA

°
2. Pada halaman List PKA klik tombol untuk mulai membuat program

kerja audit

Create PKA
BEE

& Primary Information

Tanggal Disusun SEPTEMBER 2021

210821

Bidang PXA »

Tentative A Objective (IAG) -

Flle Edit View Insen Format Tools

Gambar 80. Halaman Create PKA
3. Pada halaman Create PKA input pada field-field yang harus diisi seperti
Bidang PKA, Tentative Audit Objective (TAO), Tujuan, Pilih Auditor, dan
Alokasi Waktu
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Bidang PKA ~

Tentalive Audit Objective (TAD) *
Necthe (TR0) File Edit View lInset Format Tools

Paragraph ~ B I

File Edit View Insert Format Tools

Paragraph ~vB I EEEE i E =

Gambar 81. Contoh field-field di Create PKA

4. Pada bagian Langkah-Langkah Kerja ketikkan langkah-langkah kerja program

kerja audit yang ada, kemudian klik tombol + Add untuk menambahkan

pada tabel Uraian Langkah-langkah Kerja. Pada tabel tersebut juga bisa
ditentukan urutan dari langkah kerjanya dengan mengatur pada kolom

Urutan. Untuk menghapus langkah kerja yang sudah ditambahkan, klik

tombol = * pada kolom Action

= Langkah-Langkah Kerja

Langkah Kerja

(isi deskripsi langkah kerja disini)

+ Add

Gambar 82. Kolom isian Langkah-Langkah Kerja

&
5. Setelah yakin dengan isiannya, klik tombol untuk menyimpan data.
Hasilnya dapat kita lihat di halaman List PKA

IV.  Mengubah Data Program Kerja Audit
Halaman mengubah data program kerja audit hanya dapat diakses oleh masing-
masing auditor yang bertugas (termasuk ketua). Untuk dapat mengakses halaman
ini caranya adalah sebagai berikut:
1. Pertama-tama pastikan Anda telah berhasil mengakses halaman List PKA.

Langkah-langkahnya ada di bagian I. Melihat List Program Kerja Audit
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Action ~

Code: PKA-1

Disusun Oleh: Tim Audit UPBJJ-UT Sur  View
Unit Kerja: UPBJJ-UT Surakarta EEdit
Judul: PKA Keuangan

= Delete

Review

Gambar 83. Mengakses halaman Edit PKA

2. Setelah Anda berada di halaman List PKA, untuk mengubah data program

kerja audit silakan pilih PKA yang akan Anda ubah datanya, lalu klik Action >

Edit

3. Llalu lakukan perubahan pada field-field yang ingin Anda ubah misal pada

bagian TAO/Tujuan/Langkah-langkah Kerja

Tentative Auxdi Objeckne (TAG) File Edit View Insert Format Tools

Paragraph v B I | FEEE EE&8 3

Terapat selisih Jumiah nominal uang kas i brankas. (nasil cash caunf) dengan saldo akhir yang tercatat di Pembukian (Buku Kas Tunai)

File Edit View Insert Format Tools

Untuk meyakinkan bahwa jumish uang kas yang ada di brankas sama dengan saldo akhir yang tercatat di Buku Kas Tunai (BKT). Jika uang yang
berada di brankas lebih besar daripada di saldo Buku Kas Tunal (BKT), Pastikan UPE.L-UT Serang mengetahul peruntukan penggunaan uang
tersebut.

Gambar 84. Melakukan perubahan data pada halaman Edit PKA

4. Setelah yakin dengan perubahannya, klik tombol E untuk menyimpan

hasil perubahannya. Hasil perubahannya bisa Anda lihat di halaman Detail

PKA

V. Menghapus Program Kerja Audit

Fitur menghapus program kerja audit hanya dapat diakses oleh masing-masing

auditor yang bertugas (termasuk ketua). Untuk dapat mengakses halaman ini

caranya adalah sebagai berikut:

1. Pertama-tama pastikan Anda telah berhasil mengakses halaman List PKA.

Langkah-langkahnya ada di bagian I. Melihat List Program Kerja Audit
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Code: PKA-1 Action ~

Disusun Oleh: Tim Audit UPBJJ-UT Sur  View
Unit Kerja: UPBJJ-UT Surakarta Edit

Judul: PKA Keuangan
3 : EDeIete j

Review

Gambar 85. Mengakses fitur hapus PKA
2. Setelah Anda berada di halaman List PKA, untuk menghapus program kerja

audit silakan pilih PKA yang akan Anda hapus, lalu klik Action > Delete

Delete Confirmation

Apakah Anda yakin ingin menghapus PKA ini?

0K Cancel

Gambar 86. Tampilan konfirmasi menghapus PKA
3. Setelah Anda meng-klik tombol Delete, maka akan muncul pop-up tampilan
konfirmasi untuk menghapus PKA. Klik OK jika Anda yakin untuk menghapus,
klik Cancel untuk membatalkan proses penghapusan PKA
4. Silakan cek pada halaman List PKA, seharusnya data PKA yang tadi dihapus

sudah hilang dari list

3.2.8 Menu Kertas Data Audit (KDA)
I.  Melihat List Kertas Data Audit
Fitur melihat list KDA dapat dilakukan oleh role-role yang berkaitan dengan
kegiatan audit tersebut, seperti masing-masing auditor yang bertugas (termasuk
ketua), auditee, dan dalnis yang bertugas. Adapun role lain seperti admin, ketua
SPI, sekretaris SPI, dan role-role lain yang diizinkan hanya mendapatkan akses
untuk melihat saja. Berikut cara untuk mengakses halaman list kertas data audit:
1. Pertama-tama pastikan Anda sudah login terlebih dahulu ke aplikasi SIAIS

dengan username dan password Anda masing-masing
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List KDA

Rekapitulasi

Statistik KDA

Gambar 87. Mengakses menu List KDA
2. Kemudian akses menu Kertas Data Audit > List KDA pada menu navigasi

untuk menampilkan list kegiatan audit yang berkaitan dengan akun Anda

(letaknya dibawah menu Program Kerja Audit)

List Kegiatan Audit

TOTALKDA  TOTALOPEN/CLOSE

ACTIVITY DATE

Gambar 88. Memilih kegiatan audit untuk mengakses halaman List KDA
3. Setelah itu pilih satu kegiatan audit yang ingin anda lihat list kertas data audit-

nya, kemudian klik pada baris kegiatan audit tersebut (sampai warna barisnya

@
menjadi gelap), lalu klik tombol (Anda bisa menggunakan fitur filter

Tahun Audit untuk menyeleksi kegiatan audit berdasarkan tahun auditnya)

List KDA
B

Code KDA-1 Action ~ Code KDA-2

i Lestari Pujiastuti, S.E. MM, Auditor. S Lestari Pujiastut, S.E, MM.

LII-UT Denpasar

UPRII-UT Denpasac

[10105] Pemahalon harga (Mark up)

i i _
PP —

Auditor: St Lestari Pujiastuti, S.E, MM.
o UPILL-UT Denpasar UPBLI-UT Denpasar

Gambar 89. Halaman List KDA
4. Maka akan tampil halaman List KDA yang berisi data-data KDA yang telah

berhasil dibuat

Il. Melihat Detail Kertas Data Audit
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Fitur melihat detail data KDA dapat diakses oleh hampir semua role pada aplikasi
SIAIS yang berhubungan dengan kegiatan audit tersebut. Berikut cara untuk
mengakses halaman detail kertas data audit:

1. Pertama-tama pastikan Anda sudah berhasil mengakses halaman List KDA

seperti pada petunjuk di bagian I. Melihat List Kertas Data Audit

Code: KDA-1 @ Action ~
Auditor: Sri Lestari Pujiastuti, S.E,, M,I\
Work Unit: UPBJJ-UT Denpasar Edit
Temuan: [10105] Pemahalan harga (M
Status: Delete

Verify

Code: KDA-3 Bukti Pendukung

Show/Hide
Auditor: Sri Lestari Pujiastuti, S.E, M.\

Gambar 90. Mengakses fitur KDA Detail
2. Selanjutnya pilih KDA yang akan Anda lihat detailnya, lalu klik menu Action >

View
KDA Detail

-— UNIVERSITAS TERBUKA
—— SATUAN PENGAWAS INTERNAL
E‘ 'E ALAMAT - JALAN CABE RAYA, PONDOK CABE, PAMULANG, TANGERANG SELATAN, 15418 KDA-2

pevERATAS Tt TELP021-7490941, FAX. 0217490147

KERTAS DATA AUDIT

Unit Kerja Wakn Audit Periode Audit Aspek Audit

UPBJJ-UT Denpasar w211

jaktiar Hertansyah Pohan, 5.E. Sri Lestari Pujiastuti, 5.E. M.M., Bahir Mukhammad

| £ |

@ Download ~ [IEEER

Gambar 91. Tampilan halaman KDA Detail

Auditor

Deskripsi Temuan 1
noio1]

3. Setelah itu akan muncul pop-up halaman KDA Detail yang berisi data detail

kertas data audit yang Anda pilih

® Download ~ Clo

PDF

Excel

Gambar 92. Tampilan menu Download PDF/Excel

4. Di halaman ini Anda juga dapat mengunduh file KDA dalam bentuk PDF dan
Excel dengan klik pada tombol Download > lalu pilih PDF/Excel

1. Membuat Kertas Data Audit
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KDA dapat dibuat oleh masing-masing auditor yang bertugas (termasuk ketua)
pada suatu kegiatan audit. Untuk membuat kertas data audit caranya adalah
sebagai berikut:

1. Pertama-tama pastikan Anda sudah berhasil mengakses halaman List KDA

seperti pada petunjuk di bagian I. Melihat List Kertas Data Audit

T
110105] Pemahalan harga (Mark up)

s [EEE

Gambar 93. Mengakses halaman Create KDA

©
2. Selanjutnya pada halaman List KDA klik tombol untuk mulai membuat
KDA

Aspek At +

Kode Temuan

bl P Fie Edit View Insert Formal Taoks Table

Gambar 94. Beberapa field input pada halaman Create KDA
3. Pada halaman Create KDA isikan field-field yang dibutuhkan seperti Aspek
Audit, Kode Temuan, Deskripsi Temuan (opsional), Rekomendasi, terus
sampai bagian terakhir yaitu input data penanggung jawab dari pihak

auditee (input Jabatan dan Nama)

4. Setelah yakin dengan data-datanya, klik tombol E untuk menyimpan
data KDA
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@ List KDA
B

Gambar 95. Tampilan halaman List KDA

5. KDA yang berhasil terbuat akan tampil pada halaman List KDA

IV. Mengubah Data Kertas Data Audit

Data KDA dapat diubah oleh masing-masing auditor yang bertugas (termasuk

ketua) pada suatu kegiatan audit. Untuk mengubah data kertas data audit caranya

adalah sebagai berikut:

1. Pertama-tama pastikan Anda sudah berhasil mengakses halaman List KDA

seperti pada petunjuk di bagian I. Melihat List Kertas Data Audit

Action ¥

Code: KDA-1
Auditor: Sri Lestari Puiji i, S.E,MN _View
Work Unit: UPBJJ-UT Denpasar Edit J
Temuan: [10105] P halan harga
Status: [EREEY Delete
Verify

Code: KDA-3

Show/Hide
Auditor: Sri Lestari Pujiastuti, S E, M.\

Bukti Pendukung

Gambar 96. Mengakses halaman Edit KDA

2. Selanjutnya pilih KDA yang akan kita ubah datanya, kemudian akses menu

Action > Edit

o Mo s selecios

[ re——

i kar penyetua sy

Gambar 97. Contoh beberapa field data KDA yang dapat diubah

3. Pada halaman Edit KDA silakan lakukan perubahan data-data sesuai

kebutuhan kita, setelah yakin dengan perubahan yang dilakukan klik tombol
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4. lJika proses perubahan data berhasil maka akan tampil pesan berhasil seperti

berikut ini:
® Edit Process Successful.

Gambar 98. Pesan berhasil mengubah data KDA

V. Catatan Terkait Fitur Autosave Pada Create dan Edit KDA
Untuk field-field bertipe textarea seperti Deskripsi Temuan, Deskripsi
Rekomendasi, Kriteria/Persyaratan, Akar Penyebab, dan beberapa field lain yang
setipe, sudah menggunakan fitur autosave. Sehingga jika kita telah menginputkan
text dalam jumlah banyak dan terjadi gagal dalam proses penyimpanan data atau
koneksi internet yang kurang baik, hal itu dapat teratasi. Data akan tersimpan
sementara di penyimpanan browser yang kita pakai (misal: Chrome atau Mozilla

Firefox)

VI. Menghapus Kertas Data Audit
Data KDA yang sudah dibuat dapat dihapus. Fitur menghapus KDA ini dapat diakses
oleh masing-masing auditor yang bertugas (termasuk ketua) pada suatu kegiatan
audit. Untuk mengubah data kertas data audit caranya adalah sebagai berikut:
1. Pertama-tama pastikan Anda sudah berhasil mengakses halaman List KDA

seperti pada petunjuk di bagian I. Melihat List Kertas Data Audit

Code: KDA-1 @ Action ~

Auditor: Sri Lestari Pujiastuti, S.E, M\ View
Work Unit: UPBJJ-UT Denpasar Edit

Temuan: [10105] Pemahalan harga
Status

Verify

Bukti Pendukung

Show/Hide

Auditor: Sri Lestari Pujiastuti, S.E, M.A

Gambar 99. Mengakses fitur Delete KDA

2. Selanjutnya pilih KDA yang akan kita hapus, kemudian akses menu Action >

Delete
Delete Confirmation
Apakah Anda yakin ingin menghapus KKA ini?
0K Cancel
Gambar 100. Pesan konfirmasi hapus KDA
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3. Setelah itu akan muncul pop-up konfirmasi untuk menghapus data KDA. Jika
memilih OK maka proses menghapus data akan dilanjutkan (data KDA akan

hilang), tombol Cancel untuk membatalkan proses penghapusan data KDA

VIl. Menanggapi Temuan Audit (Untuk Auditee)
Fitur menanggapi temuan audit ini hanya bisa diakses oleh auditee (kepala
UPBJJ/Unit) yang bersangkutan dari masing-masing kegiatan audit. Tahapannya
adalah sebagai berikut:
1. Pertama-tama pastikan Anda sudah berhasil mengakses halaman List KDA

seperti pada petunjuk di bagian I. Melihat List Kertas Data Audit

Action v

Auditor: Sri Lestari Pujiastuti, SE,MM View

Work Unit: UPBJJ-UT Denpasar Tanggapan
Temuan: [10101] Belanja dan/atau pen(
Status: ooy Tindak Lanjut

Gambar 101. Mengakses halaman Tanggapan KDA
2. Selanjutnya pilih KDA yang akan kita tanggapi, kemudian akses menu Action >

Tanggapan

[anggapan KDA

[EL—
Koas

Kode KDA +

Gambar 102. Form Tanggapan KDA
3. Pada halaman Tanggapan KDA isikan tanggapan Anda terhadap temuan pada

=
field Tanggapan dan jika sudah yakin klik tombol untuk menyimpan

hasil tanggapan

VIII.  Menindaklanjuti Temuan Audit (Untuk Auditee)
Fitur menindaklanjuti temuan audit hanya bisa diakses oleh auditee (kepala
UPBJJ/Unit) yang bersangkutan dari masing-masing kegiatan audit. Tahapannya

adalah sebagai berikut:
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1. Pertama-tama pastikan Anda sudah berhasil mengakses halaman List KDA

seperti pada petunjuk di bagian I. Melihat List Kertas Data Audit

Code: KDA-2 Action ¥

Auditor: Sri Lestari Pujiastuti, SE,MM View
Work Unit: UPBJJ-UT Denpasar Tanggapan

Temuan: [10101] Belanja dan/atau pen
Status: 220 Tindak Lanjut

Gambar 103. Mengakses halaman Tindak Lanjut KDA

2. Selanjutnya pilih KDA yang akan kita tindaklanjuti, kemudian akses menu

Action > Tindak Lanjut

& Tindak Lanjut KDA

2021-09-2

Dolumen Tindak Lanjut «
Browse...| No files selected

Yo iy Choose ik v e .

Deseription »

Gambar 104. Contoh field Tindak Lanjut KDA
3. Pada halaman Tindak Lanjut KDA silakan arahkan ke bagian Tindak Lanjut
KDA. Disitu terdapat field Tgl. Tindak Lanjut (auto-generate), Dokumen
Tindak Lanjut (untuk mengunggah file tindak lanjut), dan Description (untuk

menuliskan deskripsi terhadap tindak lanjut temuan)

4. lJika sudah yakin klik tombol E untuk menyimpan data tindak lanjut

IX.  Melakukan Verifikasi Tindaklanjut Temuan Audit
Setelah temuan selesai ditindaklanjuti oleh auditee, ketua atau anggota-anggota
dari tim auditor dapat melakukan verifikasi terhadap tindaklanjut tersebut.
Tahapan melakukan verifikasi tindaklanjut adalah sebagai berikut:
1. Pertama-tama pastikan Anda sudah berhasil mengakses halaman List KDA

seperti pada petunjuk di bagian I. Melihat List Kertas Data Audit
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Action ~

Auditor: Sri Lestari Pujiastuti, SE,MA\ View
Work Unit: UPBJJ-UT Denpasar
Temuan: [10105] Pemahalan harga (M

Status: Delete

{ Verify |

Bukti Pendukung

Edit

Show/Hide

Auditor: Sri Lestari Pujiastuti, S.E, M.\

Gambar 105. Mengakses halaman Verifikasi Tindak Lanjut KDA
2. Selanjutnya pilih KDA yang akan kita verifikasi, kemudian akses menu Action >

Verify

8 Summary KDA

KDAINDEX ASPEKAUDIT KODETEMUAN KRITERIA AKARPENYEBAB AKIBAT TGL PENYELESAIAN  STATUS

KDA2 st KTP003 JUDUL KRITERIA/PERSYARATAN s pemyebati i akibar 29 Jonuan 2021 [oen]

w5123

]
O,
tes 321 801 nsdtesd fa dfa sdf asdfa sdfasdlasdt
KODE TINDAK LANJUT ot TGL TINDAK LANJUT DESKRIPSI STATUS VERIFIKAS! VERIFIKASI NOTES
KTLoon Kepal UPBLI-UT Denpasar 08 Februari 2021 s response kia-2 denpasar [t vireren |

FLESIZE DOWNLOAD

Gambar 106. Informasi Summary KDA dan Dokumen Tindak Lanjut
3. Pada halaman Verifikasi Tindak Lanjut KDA, terdapat informasi singkat
mengenai temuan, informasi status KDA, juga status verifikasi KDA.
Selanjutnya ada informasi mengenai dokumen tindaklanjut yang telah di
unggah auditee, yang dapat memberikan kita informasi tambahan terkait

proses tindaklanjut terhadap temuan tersebut

& Verifikasi Tindak Lanjut KDA

Tyl Verifikasi + SEPTEMBER 2021

T we

2021-09-21

Deskripsi Verifikasi

Gambar 107. Bagian yang harus diisi verifikator
4. Yang perlu diperhatikan pada saat proses verifikasi yaitu pada bagian
Verifikasi Tindak Lanjut KDA. Isikan Deskripsi Verifikasi (jika ada/opsional)

dan Status verifikasi dari tindaklanjutnya (Open/Close)
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5. Jika Anda sudah yakin dengan isiannya klik tombol E

X. Menyembunyikan & Menampilkan KDA Dari Halaman Auditee
(Show/Hide)

KDA yang sudah dibuat, status visibilitasnya tidak langsung bisa dilihat oleh user

dengan role auditee. Auditor bisa menentukan KDA mana saja yang bisa/tidak bisa

dilihat oleh auditee. Tujuannya yaitu untuk menghindari kesalahan jika ada KDA

yang memang belum layak untuk dilihat oleh auditee dikarenakan masih dalam
proses finalisasi. Untuk mengakses fitur ini caranya adalah sebagai berikut:

1. Pertama-tama pastikan Anda sudah berhasil mengakses halaman List KDA

seperti pada petunjuk di bagian I. Melihat List Kertas Data Audit sebagai role

auditor (ketua/anggota)

Action ~

Auditor: Sri Lestari Pujiastuti, SE,MN View
Work Unit: UPBJJ-UT Denpasar
Temuan: [10105] Pemahalan harga (M

Status: @ Delete

Verify

Edit

Code: KDA-3

Bukti Pendukung

Show/Hide
Auditor: Sri Lestari Puji i, S.E, M.

Gambar 108. Mengakses fitur Show/Hide KDA
2. Setelah itu pilih KDA yang akan Anda tampilkan/sembunyikan ke auditee, lalu

pilih menu Action > Show/Hide

Show/Hide KDA Confirmation

Sembunyikan KDA ini dari Auditee ?

OK Cancel

Gambar 109. Pop-up konfirmasi menyembunyikan KDA dari auditee

3. Selanjutnya akan muncul pop-up Konfirmasi Show/Hide KDA.

a. Jika saat ini status visibilitas adalah Show (atau ditandai dengan ikon -
), artinya Anda akan melakukan konfirmasi untuk menyembunyikan KDA

tersebut
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b. Begitupun sebaliknya, jika status visibilitas KDA saat ini adalah Hide
(ditandai dengan ikon | ), artinya Anda akan melakukan konfirmasi
untuk menampilkan data KDA tersebut

4. lJika Anda yakin klik OK untuk melanjutkan, jika ingin membatalkan klik Cancel

Xl.  Melihat File Bukti Pendukung Temuan
KDA vyang sudah dibuat biasanya memiliki file bukti pendukung temuan di
dalamnya. File-file tersebut ditempatkan pada satu halaman khusus yang berisi list
file-file bukti pendukung temuan. Untuk mengakses halaman ini caranya adalah
sebagai berikut:
1. Pertama-tama pastikan Anda sudah berhasil mengakses halaman List KDA
seperti pada petunjuk di bagian I. Melihat List Kertas Data Audit sebagai role

auditor (ketua/anggota)

Action ~

Auditor: Sri Lestari Pujiastuti, SE, M\ View
Work Unit: UPBJJ-UT Denpasar
Temuan: [10105] Pemahalan harga (M

Status: Delete

Verify

Bukti Pendukung

Show/Hide

Edit

Auditor: Sri Lestari Pujiastuti, S.E, M.\

Gambar 110. Mengakses halaman Bukti Pendukung Temuan
2. Setelah itu pilih KDA yang akan Anda lihat bukti pendukung temuannya, lalu

pilih menu Action > Bukti Pendukung

Bukti Pendukung Temuan

DO Detail Information

Nama Kegiatan [Tes] Audit Operasional | UPBJJ-Denpasar

KDA Index KDA-2

Temuan [10101] Belanja den/atau pengadaan barang/jasa fikif

File List

comes-home-office-designs-furniture-placement-11 Action ~

File Name:  comer-home-office-designs-fumiture-placement-11 jpg J
FileSizee 33KB .
Added: 2021-01-2320.09:39 2]

Gambar 111. Halaman Bukti Pendukung Temuan
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3. Pada halaman Bukti Pendukung Temuan terdapat informasi Nama Kegiatan,
Index KDA yang Anda pilih, Kode Temuan beserta penjelasannya, juga list file

bukti pendukung temuan yang bisa kita unggah

Xll.  Melihat Data Rekapitulasi Temuan Audit
Untuk mengakses halaman Rekapitulasi Temuan Audit tahapannya adalah sebagai
berikut:
1. Pertama-tama pastikan Anda telah login ke dalam aplikasi SIAIS dengan

username dan password Anda masing-masing

List KDA

Rekapitulasi

Statistik KDA

Gambar 112. Mengakses halaman Rekapitulasi KDA
2. Setelah itu akses halaman Rekapitulasi melalui menu navigasi Kertas Data

Audit > Rekapitulasi

Rekapitulasi Temuan Audit

Search
JUMUAR
TEMUAN

KODE NILAI  REKOMENDAS!
TEMUAN JENIS TEMUAN KASUS  (RP) ®P)

Gambar 113. Tampilan tabel pertama rekapitulasi temuan audit
3. Pada halaman Rekapitulasi Temuan Audit terdapat 2 (dua) buah tabel:

a. Tabel pertama berisi informasi rekap total temuan berdasarkan kode
temuan. Di tabel ini juga terdapat informasi nominal temuan dan
rekomendasi. Nilai angka pada kolom Kasus bisa di klik, dan akan
muncul pop-up detail rekap temuan berdasarkan kode temuan yang ada

b. Tabel kedua berisi informasi seluruh temuan yang ada beserta info

UPBJJ/Unitnya. Di tabel kedua ini informasi bisa dikatakan lebih lengkap

Buku Petunjuk Penggunaan Aplikasi Hal 68 dari 106
SISTEM INFORMASI AUDIT INTERNAL SPI



karena terdapat kolom Deskripsi Temuan berikut Kode Temuan,
Kriteria/Persyaratan, Deskripsi Rekomendasi, Rencana  Tgl.

Penyelesaian, dan Status dari temuan (Open/Close)

Xlll.  Melihat Data Statistik Temuan Audit
Untuk mengakses halaman Statistik KDA tahapannya adalah sebagai berikut:
1. Pertama-tama pastikan Anda telah login ke dalam aplikasi SIAIS dengan

username dan password Anda masing-masing

List KDA

Rekapitulasi

l Statistik KDA l

Gambar 114. Mengakses halaman Statistik KDA

2. Setelah itu akses halaman Statistik KDA melalui menu navigasi Kertas Data

Audit > Statistik KDA

@ Statistik KDA

Total Temuan Per Tahun

Gambar 115. Tampilan grafik total temuan per tahun
3. Pada halaman Statistik KDA terdapat info grafik Total Temuan Per Tahun,
Total Temuan Per Kategori, dan Jumlah per masing-masing temuan.

Semuanya bisa di filter berdasarkan Tahun Audit, UPBJJ/Unit, dan Kategori

Temuan

3.2.9 Menu Sistem Pengendalian Manajemen (SPM)

l. Membuat Data SPM

Buku Petunjuk Penggunaan Aplikasi Hal 69 dari 106

SISTEM INFORMASI AUDIT INTERNAL SPI



Fitur penilaian SPM ini dapat diakses oleh masing-masing auditor yang bertugas
(termasuk ketua) ke UPBJJ/Unit tersebut. Untuk mulai membuat data penilaian
SPM caranya adalah sebagai berikut:

1. Pertama-tama akses menu List SPM pada menu navigasi pada sisi kiri

halaman web SIAIS

List SPM

Statistik SPM

Gambar 116. Mengakses halaman List SPM dari menu navigasi
2. Pada halaman List SPM pilih kegiatan audit yang akan dinilai, dengan klik

pada area baris kegiatan audit tersbut (sampai warna latar baris terlihat agak

©
gelap), kemudian klik tombol

@ List SPM

Gambar 117. Mengakses form Create SPM dari halaman List SPM
3. Pada halaman Create SPM bagian Unsur Penilaian isikan nilai dari masing-

masing kriteria penilaian pada kolom Nilai (kategori penilaian masing-masing

kriteria berbeda-beda), setelah yakin klik tombol E
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+ Unsur Penilaian

A Lingkungan Pengendalian . 0(0%)
1 Ap ol pe HKA G =
2 Apakah o
1 Jika disusun oleh Penm
unit P yang dan konsisten dalam mengambil tindakan ? o
4. Apakah pimpinan unit mampu mengambil keputusan yang akurat, cepat dan bijaksana; sesuai dengan aturan yang berlaku dan berpegang teguh pada keadikan dan o
xebenaran?
5. Apakah dilakukan kegiatan pembinaan staf secara formal yang sesuai kebutuhan? Sepert peningkatan kompetensi, pemberian pelatian dsb °
6 Apakah dilakukan pembinaan staf secara informal? o
ara requier,baik °
8. Apakali pertemuan terscbut berlangsung dua-arah dan demokratis? =
B.  Penilaian Resiko 0(0%)
1 s terjadinya daya serap rendah, SP. dalam pencapaian target d o
2. Apakah ada anisipasi pencegahan oleh pimpinan unit atas kejadian yang berindikas: penyimpangan yang dilakuskan oleh staf? o
3. Apakah pimpinan unit melakukan penilaian risiko tehadap pemanaatan ase? o
C. Kegiatan Pengendalian 0(0%)
1. Pada akhit/awal tahun kegiatan, apakah pimpinan unit melakukan evaluasi atas kegiatan yang telah berjalan dan memberikan rekomendasi? o
bersama seluruh staf 5 o
una penga: ¢ o) secara teratur ? Jika VA, siapa dan sebutkan frekuensinya P

Gambar 118. Form Create SPM bagian Unsur Penilaian
4. lJika seluruh kolom Nilai telah diisi maka pada bagian Nilai Total Akhir akan
otomatis melakukan kalkulasi nilai-nilai tersebut untuk mendapatkan nilai

akhir dalam persentase.
Nilai Total Akhir 76.49%

Gambar 119. Kolom Nilai Total Akhir hasil dari kalkulasi nilai-nilai yang diinput

Il.  Merubah Data SPM
Data penilaian SPM yang berhasil dibuat sebelumnya bisa kita ubah untuk kolom
masing-masing Nilai-nya. Halaman ini bisa diakses oleh auditor-auditor yang
bertugas pada kegiatan audit tersebut. Untuk merubah data SPM caranya adalah
sebagai berikut:
1. Pertama-tama akses menu List SPM pada menu navigasi pada sisi kiri

halaman web SIAIS

List SPM

Statistik SPM

Gambar 120. Mengakses halaman List SPM dari menu navigasi
2. Pada halaman List SPM pilih kegiatan audit yang akan diubah, dengan klik

pada area baris kegiatan audit tersbut (sampai warna latar baris terlihat agak

s
gelap), kemudian klik tombol
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Show 10 v entries Soaik
No. UNITKERIA Tme PENILAI NILAIAKHIR STATUS PENILALAN
1 UPBJJ-UT Denpasar Baki 766% [Soon ]
2 UPBUIUT Denpasar Montoring Tn E o [ muiavona
T UPALAUT Sur Keguatan Audit Oper Ahmad Binads, S § 6498 [ |
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|
Gambar 121. Mengakses form Edit SPM dari halaman List SPM
3. Pada halaman Edit SPM bagian Unsur Penilaian silakan ubah nilai dari

masing-masing kriteria penilaian pada kolom Nilai sesuai dengan nilai yang

seharusnya, setelah yakin klik tombol E untuk menyimpan hasil

perubahan

# Unsur Penilaian

NO.  UNSUR NiLal
A Lingkungan Pengendalian 18.75 (75.00%)
1 — diumunmican ke sehuruh s1377 .
2 Apakah pimpinan unit melaksanakan RKA secara benar dan bak? N
3 Apakah pampnan vt semontiasa - dan dalam mengarmbiltindakan ?

4. Apakah pimpinan unit mampu mengambil keputusan yang akurat, cepat dan bijaksana; sesuai dengan aturan yang berlaku dan berpegang tequh pada keadilan dan
kebenaran?

5 Apakah ddak af secara formal yang se Seper Komperens, pemberian pelatinan dsb
6. Apakah dilakukan pembinaan staf secara informal?

7 Apakah ddalkan pertemsian koordinsi secara reguler bk farmal ateupun informer? .
& Apakah pertermuan tersebut berlangsung dua-arah dan demokatis?

B Penilaian Resiko 8 (80.00%)

1. Apakah pampinan unit melakukan anak i Ipenen penyebab terjacings daya serap fendah, P rendah dan Kegagalan dalam pencapsian targer di RKA?

atas kejadisn yang

3, Apakah pampinan uait melskiukan penila

ik eshadap pemanfastan sset? 4

€. Kegiatan Pengendalian 31.27 (78.18%)

1. Pada akhir/awal tahun kegiatan, apakah pimpinan unit melakukan evaluasi atas kegiatan yang telah berjalan dan memberikan rekomendasi?

Gambar 122. Form Edit SPM bagian Unsur Penilaian
4. Jika seluruh kolom Nilai telah disesuaikan, maka pada bagian Nilai Total Akhir
akan otomatis melakukan kalkulasi nilai-nilai baru yang telah diubah

sebelumnya
Nilai Total Akhir 75.32%

Gambar 123. Kolom Nilai Total Akhir yang ter-update setelah perubahan nilai

lll.  Melihat Detail Data SPM
Data hasil Create SPM ataupun Edit SPM bisa dilihat pada halaman Detail SPM ini.
Halaman ini bisa diakses oleh auditor-auditor sebagai penilai dan auditee sebagai
unit yang dinilai. Untuk melihat detail data SPM caranya adalah sebagai berikut:
1. Pertama-tama akses menu List SPM pada menu navigasi pada sisi kiri

halaman web SIAIS
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List SPM

Statistik SPM

Gambar 124. Mengakses halaman List SPM dari menu navigasi
2. Pada halaman List SPM pilih kegiatan audit yang akan dilihat, dengan klik

pada area baris kegiatan audit tersbut (sampai warna latar baris terlihat agak

@
gelap), kemudian klik tombol
@ List SPM
B HEA

Tahun Audit 2021 v
Show 10 v entries v
No. UNITKERIA Tme PENILAI NILAIAKHIR STATUS PENILAIAN
1 UPRL-UT Denpasar es] onal UPRLI-Denpasar Baiciar Hertansyan Pohan, S £ Te6k o]

2 UPBII-UT Denpasar ontor L UPBII-UT Denpasan [Tesd] ox [ ey o |

S UPBLUT Suakarta Kegiatan Auit Operasional Akhir Tahun UPBJ-UT Surakarta Abmad Binadi, SE 76.49% [ooin ]

4 UPRL-UT Makassar ‘Manitoring Kegiatan Audit Operasional UPBJ-UT Makassar E o [emowonas ]
Showing 110 4 of  entries -

Gambar 125. Mengakses halaman Detail SPM dari halaman List SPM
3. Setelah itu akan tampil halaman Detail SPM yang berisi informasi detail nilai-
nilai pada bagian Unsur Penilaian yang telah kita buat/ubah sebelumnya

beserta Nilai Total Akhir

@ Detail SPM

&
Downioad
& Detail Information

SPM Code * SPM-0008

Setal SPM

KEY VALUE

Created By ahmad binads

Created Date 2021-09-13 203503
Unit Kerja
Modified By none
Modified Dete
Periode Audit
Tanggal Audit 15 Agustus 2021 s/d 21 Agustus 20
Auditor Abmad Binad, S £

+ Unsur Penilaian

NO. UNSUR NILAI

A, Lingkungan Pengendalian 18.75 (75.00%)

Gambar 126. Halaman Detail SPM

®
4. Untuk mengunduh hasil dari penilaian SPM, silakan klik tombol pada
halaman Detail SPM. File yang didownload bertipe data PDF
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IV. Menghapus Data SPM
Data penilaian SPM vyang telah kita buat bisa kita hapus jika diperlukan.
Menghapus data SPM bisa dilakukan oleh auditor-auditor yang bertugas pada
kegiatan audit tersebut. Caranya adalah sebagai berikut:
1. Pastikan Anda sudah berada pada halaman List SPM. Pada halaman tersebut,
pilih kegiatan audit yang akan dilihat, dengan klik pada area baris kegiatan

audit tersbut (sampai warna latar baris terlihat agak gelap), kemudian klik

2 u
3 UPBJJ UT Surakarta

4 UPBJJ-UT Makassar

1104 of 4 emies

Gambar 127. Mengakses form Delete SPM dari halaman List SPM
2. Setelah itu akan tampil halaman Delete SPM yang berisi pesan konfirmasi dari

sistem untuk melakukan penghapusan data SPM tersebut. lJika ingin

@
melanjutkan silakan lanjutkan dengan klik tombol pada bagian atas

form

Attention!

You are about to Delete this SPM by clicking "Delete” button

Gambar 128. Pesan konfirmasi menghapus data penilaian SPM

3. Maka data penilaian SPM tersebut akan dihapus. Anda bisa cek pada halaman

List SPM pada kolom kegiatan audit akan berstatus I

3.2.10 Menu Cashcount
I.  Membuat Data Cash Count
Untuk membuat data cash count caranya adalah sebagai berikut:

1. Pertama-tama pastikan Anda sudah mengakses menu Cashcount dari menu

navigasi pada sisi kiri halaman
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List Cashcount

Gambar 129. Mengakses menu Cashcount

2. Pada halaman Cashcount Lists, pilih kegiatan audit dengan klik pada area

[+]
i i i i i
baris kegiatan audit tersebut, kemudian klik tombol

Tanggal Tutup * SEPTEMBER 2021 o]
nwoowe ™ = s
[ [
7 8

2021-09-01

Jumlah Penerimaan * Rp 0

Jumiah Pengeluaran « Ap 0

Saldo Buku * Rp 0

Pengeluaran/Penerimaan yang Rp 0
belum tercatat di BKT

Gambar 130. Form Create Cashcount
3. Pada halaman form Create Cashcount, isikan field-field yang dibutuhkan
seperti Jumlah Penerimaan, Jumlah Pengeluaran, Saldo Buku, dan

seterusnya sampai bagian Fisik Saldo Kas dan Data Tanda Tangan. Setelah
yakin klik tombol E
4. lJika proses berhasil akan muncul pesan berhasil seperti berikut ini:
& Create Process Successful.

Gambar 131. Pesan berhasil create cashcount

5. Silakan cek pada baris kegiatan auditnya, seharusnya kolom Status Cashcount

sudah berubah menjadi

Il.  Mengubah Data Cash Count

Untuk merubah data cash count caranya adalah sebagai berikut:
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1. Pertama-tama pastikan Anda sudah mengakses menu Cashcount dari menu

navigasi pada sisi kiri halaman

List Cashcount

Gambar 132. Mengakses menu Cashcount

2. Pada halaman Cashcount Lists, pilih kegiatan audit dengan klik pada area

Vs
baris kegiatan audit tersebut, kemudian klik tombol

Cashcount Lists
VR
Tohun Aust | AllTahun

e
EZEm
e

m

Gambar 133. Mengakses form edit cashcount

3. Pada halaman Edit Cashcount silakan update field-field yang perlu diganti,

™
setelah yakin klik tombol untuk menyimpan hasil editnya

Tanggal Tuwp * SEPTEMBER 2021 [c]
Mo W ® B
2021-09-01
Jumiah Penerimaan = Rp | 500000
2, 60
Jumiah Pengeluatan « Rp | 450000
50, 006,
Saldo Buku » Rp | 50000.00
3, 608,
Pengeluaran/Penerimaan yang gy | 1000
belum tercatat di BKT =
™

Gambar 134. Form edit cashcount

4. lika proses edit berhadil akan muncul pesan sukses seperti di bawah ini:
@ Edit Process Successful.

Gambar 135. Pesan sukses berhasil edit cashcount
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lll.  Melihat Detail Data Cash Count
Untuk melihat detail data cash count tahapannya adalah sebagai berikut:
1. Pertama-tama pastikan Anda sudah berada pada halaman Cashcount Lists,

lalu pilih kegiatan audit dengan klik pada area baris kegiatan audit tersebut,

@
kemudian klik tombol

Tahun Audit Al Tahun v

Show 10 v entnes Sorch
No. KEGIATAN AUDIT UPBLIUNIT STATUS CASHCOUNT
=

- UPBJ-UT Denpasar

showing 1105 of e ]

1J-UT Denpasar, Ball

UPBLI-UT Mikassan UPELL-UT Maks

5 Kegintan Audit Operasionial Akfic Tahan UPBUI-UT Surakarta

Gambar 136. Mengakses halaman Cashcount Detail
2. Saat ini Anda berada di halaman Cashcount Detail yang berisi informasi detail

dari data cash count pada kegiatan audit yang Anda pilih

&
Download
48 Detail Information

Nama Kegiatan Kegiatan Audit Operasional Akhir Tahun UPBJJ-UT Surakarta

Cashcount Code * CCT-0006

Max._ 15 characters length of Cashcount Code

Tanggal Tutup * 2021-09-01

Jumlah Penerimaan * Rp 500000 <
(A = 506,600)

Jumlah Pengeluaran * Rp | 450000 ¢
(B = 456,600)

Saldo Buku = Rp | 50000.00 <

(C=A - B =56,000)

Pengeluaran/Penerimaan yang Rp | 10000 ~
belum tercatat di BKT *
(0 - 10,000)

Gambar 137. Halaman Cashcount Detail

IV. Menghapus Data Cash Count
Berikut ini tahapan untuk menghapus data cash count yang sebelumnya sudah

dibuat:
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1. Pertama-tama pastikan Anda sudah mengakses menu Cashcount dari menu

navigasi pada sisi kiri halaman

List Cashcount

Gambar 138. Mengakses menu List Cashcount dari

2. Pada halaman Cashcount Lists, pilih kegiatan audit dengan klik pada area

o}
baris kegiatan audit tersebut, kemudian klik tombol untuk mulai

menghapus data cashcount yang telah dibuat

Cashcount Lists

Search
NO. KEGIATAN AUDIT UPBLUNIT STATUS CASHCOUNT

UPBLI-UT

UPBUJ.UT Surakarta

Gambar 139. Mengakses halaman Delete Cashcount
3. Setelah itu Anda akan masuk ke halaman Delete Cashcount untuk
penghapusan data cashcount. Di halaman ini terdapat pesan pemberitahuan

bahwa saat ini Anda akan menghapus data cashcount

Attention!

You are about to Delete this Cashcount data by clicking "Delete” button

Gambar 140. Pesan konfirmasi penghapusan data cash count

o}
4. Setelah yakin, klik tombol untuk submit form Delete Cashcount. Cek

kembali halaman Cashcount Lists, jika data cash count berhasil terhapus

NO

seharusnya saat ini kolom Status Cashcount menjadi fiae

3.2.11 Menu Berita Acara

I.  Membuat Berita Acara Sepakat / Tidak Sepakat
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Membuat berita acara sepakat/tidak sepakat bisa dilakukan oleh setiap auditor
yang bertugas (termasuk ketua) ke UPBJJ/Unit yang diaudit. Tahapannya adalah
sebagai berikut:

1. Pertama-tama akses menu List Berita Acara pada menu navigasi di sisi kiri

halaman web SIAIS

List Berita Acara

Rekapitulasi

Gambar 141. Mengakses halaman List Berita Acara dari menu navigasi

2. Pada halaman List Berita Acara pilih kegiatan audit yang akan kita buat berita

acaranya, dengan klik pada area baris kegiatan audit tersbut (sampai warna

©
latar baris terlihat agak gelap), kemudian klik tombol

List Berita Acara

Show 10 v entries Search

Tahun Audit | All Tahun

BERITAACARA
No. KEGIATAN AUDIT UPBJI/UNIT SEPAKAT TIDAK SEPAKAT
onal UPBLS-UT Denpasar, alt UPILI-UT Denpasar [ions o |

UPRL-UT B

UPBJJ-UT M

LN ¢

UPBI-UT D

UPBJJ-UTD

UPBII-IT S

UPBJJ-UT Makassar

Gambar 142. Mengakses form Create Berita Acara dari halaman List Berita Acara
3. Pada form Create Berita Acara, masukkan Tipe Berita Acara (Sepakat/Tidak
Sepakat), No. Surat Tugas, dan beberapa bagian lainnya yaitu pemilihan
temuan yang disepakati/tidak disepakati (bisa lebih dari 1 temuan), serta

bagian isian Saksi-saksi (dari Auditee)
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~
<
B feset E
& Primary Information

Nama Kegiatan

Kode Berita Acara *

Tipe =

Tanggal Buat =

No. Surat Tugas *

Kegiatan Audit Operasional Akhir Tahun UPBJJ-UT Surakarta

BAC-0009

Max_ 15 characters length of Berita Acara Code

Pilih v

SEPTEMBER 2021

su MO ] WE ™ FR SA

2021-09-13

& Pilih Temuan

NO.KDA KODETEMUAN

Gambar 143. Form Create Berita Acara

JUMLAH NILAI (RP) REKOMENDASI TGL. TINDAK LANJUT

4. Setelah yakin dengan isian kita, klik tombol E untuk menyimpan data.

lika berita acara berhasil terbuat, maka pada kolom Sepakat/Tidak Sepakat

(sesuai tipe berita acara yang dipilih) akan muncul tombol B s (View dan

Edit) Berita Acara

Il.  Melihat Dan Mengunduh File Berita Acara

Berita acara yang berhasil kita buat sebelumnya bisa kita lihat hasilnya dalam

bentuk file PDF dan mengunduhnya untuk disimpan di direktori pribadi kita

masing-masing. Caranya adalah sebagai berikut:

1. Pada halaman List Berita Acara, kolom Sepakat / Tidak Sepakat (tergantung

berita acara apa yang kita buat sebelumnya) terdapat 2 (dua) tombol

tambahan yang akan muncul ketika berita acara tersebut berhasil terbuat,

yaitu tombol View dan Edit ( B s )
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2. Untuk melihat hasil berita acara klik tombol View

List Berita Acara

Show 10 v entries Search
BERITA ACARA
No. KEGIATAN AUDIT upBIUNIT SEPAKAT TIDAK SEPAKAT

IPBJ-UT Denpasar, Bal

9 ,
7 ,
s —— T — .
6 Keaiotan Audit Opcrasional Akhir Tahun UPBJJ UT Surakaria UPBL UT Surakarta |
7 atan Aucit Operasionsl UPR) UT Makassor PRI UT Makassar o]

shonoq1 07t T et o

Gambar 144. Mengakses PDF View file berita acara

= , maka akan tampil file

hasil export berita acara dalam bentuk PDF view

[ |z - b Aot Zom v LICH-I I

p UNIVERSITAS TERBUKA
L | J SATUAN PENGAWAS INTERNAL

Alama ; Jalan Cobe sy, Porsioh Gat, Parmuliey, Taregerang Salaian, 15415
Top. 021748081, Fas. 021 7430147

BERITA ACARA [TES] AUDIT OPERASIONAL UPBJJ-DENPASAR
TAHUN ANGGARAN

Pada hari ini Kamis, 13 Saptembar 2021 bartampat di UPBL-UT Denpasar yang bartandatangan di bawah ini:

Nama Anmad Binadi, S.E.
NP 112233445566AGT01
Jabatan dalam tm Ketua Tim Audit

‘Sefaku Tim Audil [Tes] Audil Opesasional UPBJJ-Denpasar sesuai dengan sural lugas nomor ABC123450001 letah
melakukan pembahasan lamuan hasi audt dengan phak AL

Nama Kepala UPBJUT Dengasar
NP 123456789101 112TKTO1
Jabatan Kepala UPBJUUT Denpasar

Bahwa satelah dilakukan audit oparasional pada tanggal 13 September 2021 sampai dengan tanggal 13 Septamber
2021 bertasarkan buki auil yang ad, terdapal lamiian dengan rincian sebaga berkut:

No. KDA Kode Temuan Jurniah Nilai Rekomendasi Tal. Tingak
() Lanjut

["koaz Tiro1011 Besania danvatan |- Pemvetoran ke kos nearaBLU |29 Jamari 2021 |

Gambar 145. Hasil view PDF file berita acara sepakat

&

3. Untuk mengunduh file PDF-nya, kita bisa klik tombol Download pada

pojok kanan-atas halaman PDF view

Mengubah Data Berita Acara Sepakat / Tidak Sepakat

Data berita acara sepakat / tidak sepakat yang telah berhasil kita buat sebelumnya,

bisa kita ubah untuk memperbaiki jika ada kesalahan misalnya saat memasukkan

temuan-temuan atau pengisian kolom saksi-saksi untuk pihak Auditee. Caranya

adalah sebagai berikut:

1. Pada halaman List Berita Acara, kolom Sepakat / Tidak Sepakat (tergantung

berita acara apa yang kita buat sebelumnya) terdapat 2 (dua) tombol

tambahan yang akan muncul ketika berita acara tersebut berhasil terbuat,

yaitu tombol View dan Edit ( B ¢ )
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Tahun Audit | Al Tahun -

Show 10 v entries

3

Test Buat Kegiatan Audi

crasional UPBLJ.UT Denpasar, Bali

Tes Kegiatan Audi

nal Banjamasin

A Taon UPTLLI-UT Makassar

UPBI-Dy

Monitoring Tindak Lanjut Hasil Audit UPBJ-UT Denpasar [Test]

6 Kegiatan Audit Operasional Athi Tahun UPB-UT Surakania

M

eguatan Aud Operasional UPELLI-UT Makassa

Gambar 146. Mengakses halaman Edit Berita Acara

BERITAACARA
KEGIATAN AUDIT UPBINUNIT SEPAKAT TIDAK SEPAKAT

UPBJJ UT Denpasar
UPELJ-UT Banjarmasin
UPILLI-UT Makassar

UPRL-UT

UPBJJ-UT Denpasar

UPBJJ-UT Surakarta

UPILLI-UT Makassar

BA

® ®

2. Untuk merubah data berita acara klik tombol Edit #, maka akan tampil

halaman Edit Berita Acara

2021-02-11

No. Surat Tugas *

ABC123450001

& Pilih Temuan

NO.
KDA KODE TEMUAN

KDA-2  [10101] Belanja dan/atau pengadaan
barang/jasa fiktif

KDA-1  [10105] Pemahalan harga (Mark up)

REKOMENDAS!

Penyetoran ke kas negara/BLU [Rp

5.000,-]
Pelaksanaan sanksi administrasi

kepegawaian

Penyetoran ke kas negara/BLU [Rp

1.500000.-]

Pelaksanaan sanksi administrasi

kepegawaian
Temuan o
+ Add
W Saksi-saksi (Auditee)
JABATAN NAMA NP
Ka. Unit Pusat Heru Pradipta 12345678001
Kasubbag TU Dony Alamsyah 12345678002

Gambar 147. Beberapa field yang dapat dirubah pada halaman Edit Berita Acara

3. Di halaman ini silakan ubah data-data yang perlu dirubah seperti misalnya

menambah/mengurangi temuan atau merubah data saksi-saksi dari pihak

auditee ataupun merubah nomor surat tugas. Setelah selesai dan yakin akan

data perubahan, klik tombol E untuk menyimpan perubahan

4. Anda bisa cek hasil perubahannya dari halaman view PDF berita acara

sepakat/tidak sepakat

IV.  Rekapitulasi Berita Acara

Halaman rekapitulasi berita acara berisi hasil rekap dari berita acara yang telah

dibuat untuk masing-masing kegiatan audit, berapa total temuan sepakat dan tidak
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sepakat pada masing-masing kegiatan tersebut. Untuk mengakses halaman ini
caranya adalah sebagai berikut:
1. Akses halaman Rekapitulasi Berita Acara dari menu navigasi, letaknya ada di

dalam sub-menu Berita Acara (Berita Acara > Rekapitulasi)

List Berita Acara

| Rekapitulasi I

@ | H

Gambar 148. Mengakses halaman Rekapitulasi Berita Acara
2. Di dalam halaman ini, terdapat fitur filter berdasarkan Periode Audit dan

UPBJJ/Unit yang ditugaskan.

Rekapitulasi

Pesiode Audit
UPBLI/Unit

TOTAL TEMUAN

no. KEGIATAN AUDIT upBLANIT SEPAKAT TIOAK SEPAXAT

Mar B.)-UT 21

udit UPELI-UT De

Gambar 149. Tampilan halaman Rekapitulasi Berita Acara

3. Untuk melihat detail temuan sepakat/tidak sepakat, silakan klik pada angka

TOTAL TEMUAN
SEPAKAT TIDAK SEPAKAT
total temuan . Jika berhasil, akan tampil pop-up yang berisi

data singkat mengenai temuan-temuan tersebut

Rekap Berita Acara Detail
Judul Kegiatan Audit (Tes] Audir Operasional UPB.J-Denpasar [ View List KDA ]
KDA DESKRIPSI TEMUAN
NO. INDEX KODE TEMUAN TEMUAN DIAUDIT OLEH NOMINAL
1 KDA-3 [20101] Pencatatan tidak/belum dilakukan atau tidak akurat . Sri Lestari Pujiastut, S E, MM Rp O,
% %Y tanggal 2021-01-27
ini gambar
burung
2 KDA-4  [30201] Penggunaan kuantitas input untuk satu satuan Ahmad Binadi, S E_tangaal Rp 55.000,
output lebih besar/tinggi dari yang seharusnya 2021-01-31
3 KDA-5 [20201] Perencanaan kegiatan tidak memadai Ahmad Binadi, S E_1anggal Rp O,
2021-01-31
Close

Gambar 150. Pop-up detail temuan berita acara

4. User juga dapat mengunduh file rekapitulasi ini untuk digunakan selanjutnya

®
dengan klik pada tombol yang ada di halaman Rekapitulasi Berita

Acara
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3.2.12 Menu LHA

Laporan Hasil Audit atau disingkat LHA merupakan sebuah dokumen yang akan di
upload oleh Ketua Tim Auditor yang berisi laporan hasil kegiatan audit Tim Auditor
ke UPBJJ atau Unit yang di audit. Anggota Tim Auditor dapat melihat dan men-
download file yang telah di upload oleh Ketua Tim Auditor.

Setelah file tersebut berhasil di upload oleh Ketua Tim Auditor, selanjutnya akan
diverifikasi oleh Pengendali Teknis. Tujuannya adalah untuk mereview dan
melakukan koreksi jika ada kesalahan dalam pelaporan kegiatan audit di UPBJJ

atau Unit yang dituju.

I.  Mengunggah File LHA (Upload)
File LHA hanya bisa diunggah oleh Ketua Tim Auditor saja. Caranya adalah sebagai
berikut :
1. Pertama-tama kita harus mengakses halaman List File LHA terlebih dahulu,
yaitu dengan memastikan bahwa kita telah login ke dalam aplikasi SIAIS
menggunakan Username dan Password kita masing-masing, setelah itu pada

menu navigasi akses menu LHA

Gambar 151. Mengakses menu LHA

2. Saatini Anda sudah berada pada halaman List File LHA. Untuk menunggah file

LHA, pertama-tama kita pilih kegiatan audit dengan klik pada area baris

&
kegiatan di tabel List File LHA, kemudian klik tombol
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LHA Lists

Tahun Audit  All Tahun
Show| 10 v entries

ahun 2019 UPBJJ-UT Bogor

UPBJ-UT Bogor

2019 UPBJ-UT Ser

UPBUJ-UT Serang

12019 UPBJJ-UT Purwokerto UPBJ-UT P

2019 UPBLJ-UT Bandung UPBJ-UT B

UPBJ-UT B

UPBJJ-UT B

No. KEGIATAN AUDIT UPBLI/UNIT STATUSLHA STATUS VERIFIKASI

UPBLJ-UT &

UPB-UT D

UPBJJ-UT Makassar UPBJJ-UT Makassa

Gambar 152. Halaman List File LHA

[oc] o]
|

3. Pada form Upload File LHA, pilih file LHA dengan klik pada tombol Browse..

kemudian kita cari direktori dimana kita menyimpan file LHA yang akan kita

unggah. Masukkan kolom Additional Info jika dibutuhkan (opsional). Setelah

itu klik tombol E untuk mulai mengunggah file

4 Primary Information
Nama Kegiatan [Tes] Audit Operasional UPB.L-Jambi

LHA Code * LHA-0014

Max. 15 characters length of LHA Code

2021-08-25

File *
Browse... | No file selected

(ddllwlwl Info J
4

Gambar 153. Form Upload File LHA

4. Jika proses unggah berhasil akan muncul pesan berhasil upload file
& Upload Process Successful.

Gambar 154. Pesan alert berhasil upload file LHA

Melihat dan Mengunduh (Download) File LHA

Semua role user pada aplikasi SIAIS bisa melihat dan mengunduh file LHA, kecuali

Auditee. Untuk melihat atau mengundubh file LHA caranya adalah sebagai berikut :
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1. Pertama-tama pastikan Anda sudah mengakses halaman List File LHA, lalu

pilih kegiatan audit dengan klik pada area baris kegiatan, kemudian klik

@

-
tombol s

0O Detail Information

Nama Kegiatan

LHA Code «

Upload Date

Additional Info

[Tes] Audit Operasional | UPBJJ-Jambi

LHA-0013

2021-08-26

File List

File Name: 1S0.8583_-_AMYunus. pdf

File Size: 783KB

Upload Date: 2021-08-2513:34:03

Locked Status:

[oeey ]
Verified Status:

Gambar 155. Halaman LHA File Detail

2. Seharusnya saat ini Anda berada pada halaman LHA File Detail. Untuk melihat

(preview) file LHA kita pergi ke bagian File List, lalu pada menu Action pilih

View. Lalu untuk mengunduh file LHA klik pada menu Action lalu pilih

Download

lll. Menghapus dan Mengunggah Ulang (Re-Upload) File LHA

Menghapus atau mengunggah ulang file LHA hanya bisa dilakukan oleh user yang

mengunggah file LHA tersebut, yaitu Ketua Tim Auditor dari masing-masing

kegiatan audit. Untuk menghapus dan mengunggah ulang file LHA, akan muncul

submenu tambahan di bawah menu Action yaitu Delete dan Re-Upload. Untuk

tahapannya adalah sebagai berikut :

1. Pertama-tama pastikan Anda sudah mengakses halaman List File LHA, lalu

pilih kegiatan audit dengan klik pada area baris kegiatan, kemudian klik

@

-
tombol s
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1SO_8583_-_AMYunus Action ~

File Name: 1S0_8583_-_AMYunus.pdf View
Download
File Size: 783KB anios
Delete
Upload Date: 2021-08-25 13:34:03
Re-Upload
Locked Status: E=
Verified Status:

Gambar 156. Submenu Action file LHA (Ketua Tim Auditor)
2. Seharusnya saat ini Anda berada pada halaman LHA File Detail. Untuk
menghapus file LHA yang sudah diunggah, pilih menu Action lalu klik menu

Delete

Delete Confirmation

Apakah Anda yakin ingin menghapus file ini?

0K Cancel

Gambar 157. Pop up konfirmasi menghapus file LHA

3. Setelah itu akan muncul pop up konfirmasi untuk menghapus file, jika Anda
yakin ingin menghapus file klik OK, jika tidak klik tombol Cancel

4. Kemudian untuk mengunggah ulang file LHA caranya sama, kita pilih menu

Action lalu klik menu Re-Upload

Re-upload File LHA

& Reupload Form

Replaced File » 1S0_8583_-_AMYunus. pdf

New LHA File «
Browse... | No file selected

Close

Gambar 158. Form Re-Upload file LHA
5. Setelah itu akan muncul pop up form Re-upload File LHA. Disitu terdapat field
Replaced File yang berisi informasi nama file yang akan di replace dengan file
yang baru. Lalu di bawahnya ada field New LHA File, kita klik tombol Browse..

untuk mencari file LHA baru yang akan kita unggah. Jika sudah ok, klik tombol

- -
untuk memulai proses re-upload file
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6. Kemudian pastikan file LHA yang baru kita unggah telah berhasil dengan
melihat kembali pada halaman LHA File Detail

IV.  Melakukan Verifikasi File LHA
Proses verifikasi file LHA hanya bisa dilakukan oleh Pengendali Teknis (Dalnis) dari
kegiatan audit masing-masing. Untuk melakukan verifikasi file LHA caranya adalah
sebagai berikut :
1. Pertama-tama pastikan Anda sudah mengakses halaman List File LHA, lalu

pilih kegiatan audit dengan klik pada area baris kegiatan, kemudian klik

View
tombol
1SO_8583_-_AMYunus Action ~

File Name: 1SO_8583_-_AMYunus.pdf View
Download

File Size: 783KB SrRod

Upload Date: 2021-08-25 13:34:03 ) )
Verify

Locked Status: = e ipioad

Verified Status: /

Gambar 159. Halaman File LHA Detail (Dalnis)
2. Seharusnya saat ini Anda berada pada halaman LHA File Detail. Untuk
menghapus file LHA yang sudah diunggah, pilih menu Action lalu klik menu
Verify

Verifikasi File LHA

& Form Verifikasi
su om0 T [ ™

m s

2021-08-25

Verifikasi ? *Ya Tidak

Deskuipsi Venfikasi

Gambar 160. Form Verifikasi File LHA
3. Setelah itu akan muncul form Verifikasi File LHA, untuk memverifikasi pilih Ya

dan tuliskan deskripsi verifikasi (opsional)
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Verifikasi File LHA

& Form Verifikasi
] ) we ™H PR SA

2021-08-25

Verifikasi ? Ya & Tidak

Alasan

Close

Gambar 161. Form Verifikasi File LHA pilhan Tidak
4. Untuk tidak memverifikasi pilih Tidak dan tuliskan alasan menolak proses

verifikasi (opsional)

3.2.13 Menu Monitoring Progress
Menu yang memungkinkan kita untuk mendapatkan informasi mengenai progress
masing-masing kegiatan audit yang dijadwalkan. Seluruh role pada aplikasi SIAIS

dapat mengakses menu ini, kecuali Auditee.

I.  Melihat List Monitoring Progress

Halaman list monitoring progress digunakan untuk melakukan monitoring
terhadap kegiatan-kegiatan audit yang sudah dijadwalkan. Informasi yang
ditampilkan diantaranya Tanggal Bertugas, Tanggal Buat Cashcount, Tanggal Buat
SPM, Tanggal Buat Berita Acara Sepakat atau Tidak Sepakat, Tanggal Upload LHA,
Tanggal Verifikasi LHA, Tanggal Submit Penilaian Auditee, Dalnis, dan Ketua Tim
Auditor. Untuk mengakses halaman list monitoring progress caranya sebagai
berikut:

1. Pertama-tama pastikan kita sudah login terlebih dahulu ke aplikasi SIAIS

menggunakan username dan password kita masing-masing

Gambar 162. Mengakses menu Monitoring Progress pada sidebar menu
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2. Selanjutnya pada sidebar menu pilih menu Monitoring Progress yang

posisinya berada pada urutan bawabh list sidebar menu

# 5 Monitoring Progress. 5 MonTorng Progress List

Monitoring Progress List

Tahun Audit All Tahun v
Show 10 v enlries Search
BERITA ACARA LHA PENILAIAN KINERJA
NO.  UPBLJ/UNIT TGL BERTUGAS CASHCOUNT EY SEPAKAT  TIDAKSEPAKAT TGLUPLOAD TGLVERIFIKASI  AUDITEE DALNIS KETUA
| UPBJ-UTBogor 17Marer2019s/d23  [CEIENEE Qe vveroses P e o ownoses IR o veveses B LR i UM Diroses P SeL i Dienses J) eetm oieroses B ol =
Marct 2019
2 UPBJ-UTSerang 10Mei20205/d16Mei  [CHNERTENONSY [ORmmpUweesey [TSNTONOTOOSYY ECTNEVICETERSY 19 Aquswus207o [MNIIIVEN EOTVIETEN [SNYTITTCE I proses |
2020
3 UPBIJUT 17Februari 20195/d23  19Apil2019 T4 Apiit200  [CROEEE DTS EIDIETES EEUDETET] 23Januai 2010 25Januai2019  [IVIETETY
Bandung Februan 2019
4 UPBJJUTBanda 05Mci2019s/d11Mei  24Apil2019  11April2019  [ECENMNENGEEETY 06 Okiober2020 11 Oktober2020 [EEMNEIEEESY 17Marcr201  [ETIEES OGS
Acen 2019

R m
Gambar 163. Halaman Monitoring Progress List

3. Seharusnya saat ini Anda berada pada halaman list monitoring progress. Di

halaman ini kita bisa melakukan filter monitoring progress kegiatan audit

berdasarkan Tahun Audit. Khusus untuk role Admin ada tambahan filter

berdasarkan Periode Audit

Il. Detail Monitoring Progress

Ada beberapa informasi monitoring yang tidak bisa ditampilkan pada halaman list
monitoring progress seperti informasi PKA dan KDA. Informasi tersebut bisa dilihat
pada halaman detail monitoring progress. User bisa memilih kegiatan audit yang
diinginkan, lalu mengakses halaman detail monitoring progressnya. Untuk

mengakses halaman detail monitoring progress caranya adalah sebagai berikut:
1. Pertama-tama pastikan kita sudah mengakses halaman Monitoring Progress
List. Untuk tahapannya bisa melihat pada sesi sebelumnya yaitu “Melihat List

Monitoring Progress”

# 3 Monitorng Progress » Monitorng Progress List
®
View
Tahun Audit All Tahun v
Show 10 v entries Search:
BERITA ACARA LHA PENILAIAN KINERJA
NO.  UPBIUNIT TGLBERTUGAS  CASHCOUNT M SEPAKAT  TIDAKSEPAKAT TGLUPLOAD TGLVERIFIKASI  AUDITEE DALNIS KETUA
1. UPBM-UTBogor 17Maret 20195/d 23 | e ownoses [ll e um oeroses i aeumo s I oo ownoses T L ALR £ Uit DPROSES B BELUM DIPROSES [ BELUM D@ROSES B BELUM DIPROSES |
Maret 2019
2 UPBIUTSerang 10Meiz0205/dTcMel [T EOERTE DTS RS 19Ausws 20 [ENEDTE DD EOETTE EUEEE
2020
T UPBIIUT rebuan 20195423 19AlZ01 1aAprizots | DT BT DG R 23 anen 201 25 w2010 IR
Bandung Februani 2019
4 UPBISUTBanda 0SMei2019s/d11Mei  24Apil2019 11 Apil2019  [SERTEEIEE 06 Okiober 2020 11 Oktober2020 [EEMINITEVEy 17Marer2010 [T EEOOEREE)
Aceh 2019
Showing 110.4 of & etries o
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Gambar 164. Halaman Monitoring Progress List
2. Setelah berhasil menuju halaman list monitoring progress, kemudian pilih
kegiatan audit yang ingin kita lihat detail monitoring progressnya. Caranya

yaitu dengan klik pada area baris kegiatan audit (sampai berubah warna

@
barisnya menjadi agak gelap) kemudian klik tombol

# > Monitoring Progress > Detall

Detail Monitoring Progress

& Detail Information

BERITAACARA LHA PENILAIAN KINERJA

UPBJJ/UNIT TGL.BERTUGAS CASHCOUNT  SPM SEPAKAT  TIDAKSEPAKAT TGLUPLOAD TGL VERIFIKASI  AUDITEE DALNIS

UPBJI-UT 17 Februari 2019 s/d 23 Februari  19Apil 2019 14Apil  CEIDEETEY EUEEED ENEEES EUEETES 23Jawan | 25Januar
Bandung 2019 2019 019 2019

STATUS

NO. KDAINDEX  AUDITDATE  TINDAKLANJUT VERIFIKASI OPEN/CLOSE

TKKAT 23 Februari 2019 =]
2 KKA-2 23 Februari 2019 | close |
Open 0

Total KDA 2 Close 2

Belum Diproses ]

Gambar 165. Halaman Detail Monitoring Progress
3. Saat ini Anda berada pada halaman Detail Monitoring Progress yang berisi

informasi tambahan PKA dan KDA

3.2.14 Menu Bahan Pendukung Audit
Halaman Bahan Pendukung Audit berisi file-file pendukung yang bermanfaat untuk
membantu kelancaran jalannya proses audit. File-file ini bisa diunduh oleh seluruh
role pada aplikasi SIAIS, kecuali Auditee. Fitur upload file pendukung audit hanya
terbatas pada role Admin saja. File yang diizinkan untuk di upload diantaranya

berekstensi .doc, .docx, .xls, .xIs, .pdf, dan seluruh file bertipe gambar (.jpg dan

.png)

I.  Mengakses List Bahan Pendukung Audit
Di halaman ini, user bisa melihat kumpulan seluruh file bahan pendukung audit
yang sudah berhasil di upload oleh Admin. User dapat mendownload seluruh file
sekaligus atau memilih beberapa file saja melalui fitur select file. Untuk mengakses

halaman ini berikut caranya:
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1. Pertama-tama pastikan Anda sudah login ke aplikasi SIAIS menggunakan

username dan password Anda masing-masing.

Gambar 166. Navigasi ke menu Bahan Pendukung Audit
2. Pada menu navigasi, pilih menu Bahan Pendukung Audit yang letaknya agak

ke bawah dari list menu navigasi

@ Bahan Pendukung Audit

Gambar 167. Halaman List Bahan Pendukung Audit

3. Saat ini Anda ada di halaman List Bahan Pendukung Audit, terdapat informasi

kolom nama dan ukuran masing-masing file

Il.  Mengunggah File Bahan Pendukung Audit

1. Pertama-tama pastikan Anda sudah mengakses halaman List Bahan

&
Pendukung Audit lalu klik tombol
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# > Master Data » Bahan Pendukung Audit > Upload

@ Bahan Pendukung Audit
HEE

& Primary Information

Upload Date * AUGUST 2021

su MO U WE TH FR SA

2021-08-08

File » ) .
| Browse... | No files selected

*You may choose file more than 1

Additional Info

4

Gambar 168. Form Upload Bahan Pendukung Audit
2. Pada form Upload Bahan Pendukung audit, pilih file yang ingin Anda upload
(browse file pada komputer Anda) lalu inputkan Additional Info (opsional)

untuk informasi tambahan/deskripsi mengenai file tersebut. Setelah yakin klik

tombol E

Ill.  Mengunduh File Bahan Pendukung Audit

Untuk mengunduh file (download) bisa dilakukan dengan 2 (dua) cara:
1. Pertama, mendownload seluruh file sekaligus dengan cara klik pada input

checklist header selector, untuk memilih seluruh file. Setelah itu klik tombol

]
untuk mendownload seluruh file
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& ®
Uplosd  Downiosa
show 10 fentries Search
FILENAME
| v @ Daftar_Pesera_lian_Hun_2019 xlsx 61K8 N & @
2 v F daiy-acrviies_sn_hante nu unsm docx 25k -
W
3 7 ﬁ’ 3 dummy-Iha-banjarmasin.docx 12k8 a8
w

4 v m tifa, wallpaper 1920x1080,jog 10368 &
5 £l ‘h Info_Kontak Penting.pdf 437128 Y4B

6 v @ FM KAS-001-RO.3 Formulir Pendaftaran Anggota KKAS pdf 90KB Y & @
7 7 V4 dummy-tha-makassar.docx 128 Y a8
W
| S—
Shownq 1107 0f 7 entnes

Gambar 169. Mendownload seluruh file bahan pendukung audit

2. Kedua, mendownload beberapa file yang kita pilih terlebih dahulu pada

(]
kolom selector file, kemudian klik tombol

& -}
Upload | Downiosd

show 10 v/etries Search

FILENAME FILESIZE

@ Dattar_Pesena_Tnan_Run_2019 xlsx 63KB Y & B

2 WW‘ dai 215k D&aE

3 VW‘ dummy.-tha-banjammasin.docx 12k8 &8

4 m ita_wallpaper_1920x1080 g 1036KB & 8

5 v ;ﬁ Info_Kontak_Penting pdf 43728 D &8

‘ gk FM-KAS-001-R0.3_Formule_Pendaftaran_Anggota KKAS pf 90K8 D 4w

7 F— dumimy-Ina-makassac docx 12k8 N & B
Showng 1107 of 7 entes [ ]

Gambar 170. Mendownload beberapa file bahan pendukung audit

3. Setelah itu Anda diharuskan untuk melakukan konfirmasi download file. Jika

ingin melanjutkan klik OK, jika tidak klik Cancel

Download Confirmation

Apakah Anda yakin ingin mendownload 7 file ini?

OK Cancel

Gambar 171. Form Download Confirmation file bahan pendukung audit

IV.  Menghapus File Bahan Pendukung Audit
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1. Untuk menghapus file, Anda dapat melihat kolom Action pada list bahan

pendukung audit yang berisi tombol untuk melihat, mendownload, dan

D & B

menghapus file

Gambar 172. Kolom Action dengan tombol View, Download, dan Delete

. [i5] .
2. Klik tombol untuk menghapus file

3. Setelah itu akan muncul konfirmasi untuk menghapus file, jika ingin

melanjutkan pilih OK, jika ingin membatalkan pilih Cancel

Delete Confirmation

Apakah Anda yakin ingin menghapus file ini?

OK Cancel

Gambar 173. Form Delete Confirmation untuk menghapus file bahan pendukung audit

3.2.15 Menu Master Data
I.  Work Unit (Unit Kerja)

Master data Work Unit berisi data-data unit kerja yang ada pada aplikasi SIAIS.

Menu ini hanya bisa diakses oleh role Admin.

Membuat Work Unit Baru
1. Pertama-tama pastikan Anda sudah login ke aplikasi SIAIS, kemudian akses

menu Master Data > Work Unit pada sidebar menu
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# 5 Master Data 5 Work Unit

Wérk Unit
HERAE

Show 10 v entries

Search
NO.  UNITCODE UNITNAME CREATEDBY MODIFIED BY STATUS
1 BAKPADMIN BAKP - Bagian Administrasi Akademik dan Kelulusan system at Sep/08/2018 10.54 nnone ACTIVE
2 BAKPLAPOR BAKP - Bagian Perencanaan dan Pelaporan system at Sep/08/2018 1054 none ACTIVE
3 BAKPREGIS BAKP - Bagian Registrasi system at Sep/08/2018 10:54 none | scrve |
4 BAKPBIRO BAKP - Kepala Buo system at Sep/08/2018 10.54 none | Acrve |

BRUKHUM BKUK - Bagian Hukum, Kerja Sama, dan Kepegawaian system at Sep/08/2018 1054 none
6 BKUKKEU BKUK - Bagian Keuangan dan Akuntansi system at Sep/08/2018 10:54 none | acve |
7 BKUKUMUM BKUK - Bagian Umum dan Kerumahtanggaan system at Sep/08/2018 10.54 none
8 BKUKBIRO BKUK - Kepala Biro system at Sep/08/2018 1054 none ACTIVE
9 BPPU BPPU - Badan Pengelola dan Pengembangan Usaha system at Sep/08/2018 10:54 none | acnve |
10 FE FE system at Sep/08/2018 10:54 none | acrve |
Showing 11010 0f 38 entries . 234 Nem Lest

Gambar 174. Halaman List Work Unit

(+]

Create

2. Pilih tombol setelah itu maka akan tampil halaman form Create Work

Unit

# > Master Data » Work Unit » Create

Create Work Unit

O
Back
&= Primary Information

Unit Code *

TEST

Max. 20 characters length of Unit Code

Unit Name * Test Work Unit

Description * ini deskripsi test work unit

Gambar 175. Form Create Work Unit

3. Masukkan input yang dibutuhkan seperti Unit Code, Unit Name, dan

Description, setelah itu klik tombol E untuk menyimpan data Work Unit

yang baru

Melihat Detail Work Unit
Untuk melihat data detail Work Unit dapat dilakukan dengan cara berikut:
1. Pertama-tama pastikan Anda sudah login ke aplikasi SIAIS, kemudian akses

menu Master Data > Work Unit pada sidebar menu
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2. Seharusnya saat ini Anda sudah berada pada halaman Work Unit List,
kemudian pilih data work unit yang ingin kita lihat detail datanya. Caranya

yaitu dengan klik pada area baris work unit (sampai berubah warna barisnya

# 5 Masies Date > Work Unit
- ° 7
View Create Edit
Show 10 v entries Search.

NO.  UNITCODE UNITNAME CREATEDBY MODIFIED BY STATUS
T BAKPADMIN BAKP - Bagian Adrministrasi Akademik dan Kellusan system at Sep/08/2018 1051 e =
2 BAKPLAPOR BAKP - Bagian Perencanaan dan Pelaporan system at Sep/08/2018 1054 e ==
3 BaxeResis BAKP - Bogian Regisuasi systom ot Sep/08/2018 1054 aome
4 BaKPERO BAKP - Kepala Bio eyetem ar Sep/08/2018 1054 none
BKUKHUM BKUK - Bagian Hukum, Kerja Sama, dan Kepegawaian eystem at Sep/08/2018 1054
6 BKUKKED BKUK - Bagian Keuangan dan Akuntansi eystem at Sep/08/2015 1051
BKUKUMUM BKUK - Bagian Umum dan Kerumahtanggaan system a1 Sep/08/2018 16:54 none
8 BKUKBIRO BKUK - Kepala Biro system at Sep/08/2018 1054 none
P BPPU - Badan Pengelola dan Pengembangan Usaha eystem ar Sep/08/2018 1054 none [cive ]
w0 e epstem an Sop/08/2018 1051 none [ocrn
At W e

Gambar 176. Memilih menu Work Unit Detail
3. lJika berhasil maka akan tampil halaman Work Unit Detail yang berisi data

detail unit kerja yang Anda pilih

# ) Master Data > Work Unit » Detail

W(Srk Unit Detall

& Primary Information

Unit Code * BKUKKEU

Max. 20 characters length of Unit Code

Unit Name * BKUK - Bagian Keuangan dan Akuntansi

Description *

\§

Active

Gambar 177. Halaman Work Unit Detail

Merubah Data Work Unit

1. Pertama-tama pastikan Anda sudah login ke aplikasi SIAIS, kemudian akses

menu Master Data > Work Unit pada sidebar menu
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# > Mastes Data > Work Unit

Work Unit
VG' cr:n l E:n 01\(!509

Show 10 v entries

NO.  UNITCODE UNITNAME

1 BAKPADMIN BAKP - Bagian Administrasi Akademik dan Kelulusan
2 BAKPLAPOR BAKP - Bagion P dan Plaporan

3 BAKPREGIS BAKP - g

4 BAKPBIRO BAKP - Ks

5 BKUKHUM KUK - Bagis | Kepegasaian
6 BKUKKEU BKUK - Bagian Keuangan dan Akuntansi

7 BKUKUMUM BKUK - Bagian Umum dan Kerumahtanggaan

8 BKUKBIRO BKUK - Kepala Biro

LI 8PPU - Badan Pengelola dan Pengembangan Usaha

0 FE FE

Showing 11010 of 38 entries

CREATEDBY
system at Sep/08/2018 10.54
system at Sep/08/2018 10,54

system at Sep/08/2018 10.54

/2018 10.54
system a1 Sep/08/2018 1054
eyetem ax Sep/08/2018 1054
system at Sep/0A/2018 1054
eyetem a1 Sep/08/2018 1054
system a Sep/08/2018 10.54

system at Sen/08/2018 10,54

MODIFIEDBY

CEEREERRREE

Gambar 178. Mengakses halaman Edit Work Unit

-AAOAAAAAAAE

2. Seharusnya saat ini Anda sudah berada pada halaman Work Unit List,

kemudian pilih data work unit yang ingin kita lihat ubah datanya. Caranya

yaitu dengan klik pada area baris work unit (sampai berubah warna barisnya

s
menjadi agak gelap) kemudian klik tombol

# > Master Data > Work Unit > Edit

Edit Work Unit

@ Primary Information

Back Reset

Unit Code *

Unit Name *

Description *

BKUKKEU

Max. 20 characters length of Unit Code

BKUK - Bagian Keuangan dan Akuntansi

merubah deskripsi BKUK

Active

AN

Gambar 179. Form Edit Work Unit

3. Ubah data sesuai yang dibutuhkan, lalu setelah selesai klik tombol E

untuk menyimpan perubahan datanya

Aktivasi/Inaktivasi Data Work Unit

1. Sama seperti melihat dan merubah data Work Unit, pastikan kita sudah

berada pada menu Work Unit List
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2. Kemudian pilih Work Unit yang ingin kita aktivasi/inaktivasi dengan klik area
pada baris data unit kerja pada tabel Work Unit sampai barisnya terpilih
(terlihat area barisnya lebih gelap). Misal kita pilih data unit kerja 'BKUK -

Badan Keuangan dan Akuntansi’ untuk merubah statusnya

# 5 Mastes Data 5 Work Unt

Work Unit
HER

Show 10 v entries

Searchy
NO.  UNITCODE UNITNAME CREATEDBY MODIFIED BY STATUS
| BAKPADMIN 'BAKP - Bagian Administrasi Akademik dan Kelulusan system a1 Sep/08/2018 10:5¢ nove
2 BAKPLAPOR BAKP - Bagian Pecencanaan dan Pelaporan eystom a1 Sep/08/2018 1054 none
3 BAKPREGIS BAKP - Bagian Registrasi system at Sep/08/2018 10.54 none | ncrove |
4 BAKPBIRO BAKP - Kepala Biro system at Sep/08/2018 10.54 none i |
5 BKUKHUM BKUK - Bagian Hukum, Kerja Sama, dan Kepegawaian system at Sep/08/2018 10.54 none
6 BKUKKEU BKUK - Bagian Keuangan dan Akuntansi system at Sco/08/2018 10.5¢ none
7 BKUKUMUM BKUK - Bagian Urnum dan Kerumahtanggaan eyetem at Sep/08/2018 1054 e
8 BKUKBIRO BKUK - Kepola B0 systom a1 Sep/08/2018 1054 none
9 BPPU BPPU - Badan Pengelola dan Pengembangan Usaha eystem ar Sep/08/2018 1054 none AcTive

0 FE FE system at Sep/08/2018 1054 none | i |
Showing 1 to 10 of 38 entries - 2 4 N Last

Gambar 180. Select unit kerja pada tabel Work Unit (On/Off)

(V]
3. Lalu klik tombol On/Off untuk mulai melakukan Aktivasi/Inaktivasi
unit kerja tersebut
4. Pada halaman Activate/Inactivate Work Unit perhatikan Warning Message.
Jika awalnya akun berstatus Active, maka seharusnya pesan yang tertulis
adalah suatu konfirmasi bahwa benar kita akan melakukan Inactivate

(Inaktivasi) terhadap unit kerja tersebut

# > Master Data > Work Unit > Activate/Inactivate

Acrtivate/lnactivate Work Unit

(0}
OnlOff
& Primary Information

Atutention!
You are about to Inactivate this Work Unit by clicking “OnlOff” buttor
Unit Code * BKUKKEU
Max. 20 characters length of Unit Code
Unit Name *

BKUK - Bagian Keuangan dan Akuntansi

Description *

Active

Gambar 181. Halaman Aktivasi/Inaktivasi unit kerja (Inaktivasi)
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5. Begitupun sebaliknya, jika status awal unit kerja Inactive, maka seharusnya
pesan yang tertulis adalah suatu konfirmasi bahwa benar kita akan melakukan

Activate (Aktivasi) terhadap unit kerja tersebut

# > Master Data > Work Unit > Activate/Inactivate

Activate/Inactivate Work Unit

(0]
OnlOff
& Primary Information

Attention!
You are about 1o Activate this Work Unit by clicking “OnlOff button

Unit Code* BKUKKEU
Max. 20 characters length of Unit Code
Unit Name

BKUK - Bagian Keuangan dan Akuntansi

Description *

Gambar 182. Halaman Aktivasi/Inaktivasi unit kerja (Aktivasi)
Jika sudah yakin akan Aktivasi/Inaktivasi unit kerja, silakan klik tombol On/Off

m untuk submit form untuk menyimpan

6. Untuk melihat status Aktif/Non-Aktif silakan menuju ke halaman Work Unit

List dan lihat pada kolom Status

Il. Audit Competencies (Kompetensi Audit)
Master data Audit Competencies berisi data-data kompetensi-kompetensi audit

yang ada pada aplikasi SIAIS. Menu ini hanya bisa diakses oleh role Admin.

Membuat Kompetensi Audit Baru
1. Pertama-tama pastikan Anda sudah login ke aplikasi SIAIS, kemudian akses

menu Master Data > Audit Competencies pada sidebar menu
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Audit Competencies
HEAE

Show 10 v entries

Search
NO.  COMPETENCY CODE NAME LEVEL DESCRIPTION CREATED BY MODIFIED BY STATUS

1 BASICAKUN Akuntansi Dasar PRIMARY Kompetensi akuntansi tingkat dasar system at Sep/06/2018 10.56 none
2 easicauom Ao Tingkar Dasar  PRIMARY Kompetensi sudit tinght desar syetem ar Sep/06/2018 1056 none [hcine |
3 COMPSDM SOM SECONDARY  Kompetens: SOM aystem ar Sep/06/2018 10.56 none
s compHUKUM Hukom SECONDARY  Kompetensi hukum eyetem at Sep/06/2018 1056 nome
5 CoMPASET Aset SECONDARY  Kompetensi ase1 eystem at Se/06/2018 1056 none [ |
6 COMPPEMBUKUAN Pembukuan SECONDARY /062018 1056 = [hce
7 OTHERS Lainnya SECONDARY lain lainlah trio.afia at Mar/29/2019 22.40 uie.afia a1 M/ 29/2019 2257 aciive
g 701 s i

Gambar 183. Halaman Audit Competencies Lists

(]
2. Pilih tombol setelah itu maka akan tampil halaman form Create Audit

Competencies

# > Master Data » Audit Competencies > Create

Create Audit Competencies

<4
Submit
= Primary Information

Competency Code *
Max 20 characters length of Competency Code
Name *
Level + - Pilih - v
Description
4

Gambar 184. Form Create Audit Competencies

3. Masukkan input yang dibutuhkan seperti Competency Code, Name, Level, dan

Description (opsional), setelah itu klik tombol E untuk menyimpan data

kompetensi audit yang baru

Melihat Detail Kompetensi Audit
Untuk melihat data detail kompetensi audit dapat dilakukan dengan cara berikut:
1. Pertama-tama pastikan Anda sudah login ke aplikasi SIAIS, kemudian akses
menu Master Data > Audit Competencies pada sidebar menu
2. Seharusnya saat ini Anda sudah berada pada halaman Audit Competencies

Lists, kemudian pilih data kompetensi audit yang ingin kita lihat detail
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datanya. Caranya vyaitu dengan klik pada area baris work unit (sampai

berubah warna barisnya menjadi agak gelap) kemudian klik tombol

@

View

# 5 Master Data > Audit Competencies

Audlt Competencies
s ]l

Show 10 v entries Eearch

NO.  COMPETENCY CODE NAME LEVEL DESCRIPTION CREATED BY MODIFIEDBY

| BASICAKUN Akuntansi Dasar PRIMARY Komperensi akuniansi tingkat dasar system a1 Sep/06/2018 10-56 none

2 BASICAUDIT Audic Tingkar Dasar PRIMARY Kompetensi audit ingkat dasar ‘syetem ar Sep/06/2018 10,56 none

3 COMPSDM SDM SECONDARY  Kompetensi SOM system at Scp/06/2018 10:56 none

4 COMPHUKUM Hukum SECONDARY  Kompetensi hukum system at Sep/06/2018 10:56 none

5 COMPASET Aser SECONDARY  Kompetensi aset system ar Sep/i none

6 COMPPEMBUKUAN Pembukuan SECONDARY  Kompetensi pembukuan eyetem ar Sep/06/2018 10,56 none

7 OTHERS Lainnya SECONDARY lain lain Iah trie.afia at Mar/29/2019 22.40

Showing 1107 of 7 entries

trie.afia at Mar/29/2019 22:57

Gambar 185. Mengakses halaman Audit Competencies Detail

3. lJika berhasil maka akan tampil halaman Audit Competencies Detail yang

berisi data detail kompetensi audit yang Anda pilih

# > Master Data » Audit Competencies > Detail

Audit Competencies Detall

Competency Code * BASICAUDIT

Max. 20 characters length of Competency Code

Name * Audit Tingkat Dasar
Level » Primary X
Description

Kompetensi audit tingkat dasar

Active

= Primary Information

Gambar 186. Halaman Audit Competencies Detail

Merubah Data Kompetensi Audit

1. Pertama-tama pastikan Anda sudah login ke aplikasi SIAIS, kemudian akses

menu Master Data > Audit Competencies pada sidebar menu
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#  Master Data 5 Audit Comperencles

Audit Competencies
A=

Show 10 v entries Search

NO.  COMPETENCY CODE NAME LEVEL DESCRIPTION CREATEDBY MODIFIED BY STATUS

1 BASICAKUN Akuntansi Dasar PRIMARY Kompetensi akuntansi ungkat dasar system at Sep/06/2018 10:56 none

2 BASICAUDIT Audit Tingkat Dasar PRIMARY Kompetensi audit tingkat dasar system ar Sep/06/2018 10:56 none

3 COMPSOM SOM SECONDARY  Kompetensi SOM system at Sep/06/2018 1056 none ACTIVE

4 COMPHUKUM Hukum SECONDARY ~ Kompetensi hukum system at Sep/06/2018 10.56 none | rcirve |

5 compaser Aset SECONDARY  Kompetensi aset system at Sep/06/2018 10:56 none ==

6 COMPPEMBUKUAN Pembukuan SECONDARY  Kompetensi pembukuan system at Sep/06/2018 1056 none ==
OTHERS Lainnya SECONDARY  lain lain lah ie.afia 5t Mar/29/2019 22.40 trie.afia a1 Mar/29/2019 2257 | scve |

Showing 1 107 of 7 entries

Gambar 187. Mengakses halaman Edit Audit Competencies
2. Seharusnya saat ini Anda sudah berada pada halaman Audit Competencies
Lists, kemudian pilih data kompetensi audit yang ingin kita lihat ubah

datanya. Caranya vyaitu dengan klik pada area baris work unit (sampai

4

berubah warna barisnya menjadi agak gelap) kemudian klik tombol e

# > Master Data > Audit Competencies > Edit

Edi'tjAudit Competencies
BB

@ Primary Information

Competency Code *

BASICAUDIT

Max. 20 characters length of Competency Code

Name * Audit Tingkat Dasar
Level » Primary o
Description

Kompetensi audit tingkat dasar (test edit)

Gambar 188. Form Edit Audit Competencies

3. Ubah data sesuai yang dibutuhkan, lalu setelah selesai klik tombol E

untuk menyimpan perubahan datanya

Aktivasi/Inaktivasi Data Kompetensi Audit

1. Sama seperti melihat dan merubah data kompetensi audit, pastikan kita
sudah berada pada menu Audit Competencies Lists

2. Kemudian pilih kompetensi audit yang ingin kita aktivasi/inaktivasi dengan

klik area pada baris data unit kerja pada tabel Audit Competencies sampai
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barisnya terpilih (terlihat area barisnya lebih gelap). Misal kita pilih data

kompetensi ‘Audit Tingkat Dasar™ untuk merubah statusnya

> Mastes Dats > Audic Comperencies

Audit Competencies
EEEE

Show 10 v entiies Search

NO. COMPETENCY CODE NAME LeveL DESCRIPTION CREATEDBY MODIFIEDBY sTaTUS
1 BASICAKUN A = PRIMARY Xo systomat 5 -
2 BASICAUDIT Audit Tingkat Dasar PRIMARY Kompetensi audit tingkat dasar system at Scp/06/2018 10.56 none
3 cowpsom Som SECONDARY _ Kompetons SOM o
4 cOMPHUKUM Hukum SECONDARY  Kompetensi hukum noe
5 COMPASET Aset SECONDARY  Kompetensi aset none
6 COMPPEMBUKUAN Pombukuan SECONDARY  Kompetensi pembukuan system at Scp/06/2018 10.56 none
7 OTHERS Lainnya SECONDARY  lain ain lah trie.afi o1 M/ 29/2015 2240 wrie.afia a1 Moi/29/2019 2257
Showing | to 7 of 7 entnes [ 1]

Gambar 189. Select unit kerja pada tabel Audit Competencies (On/Off)

(V]
3. Lalu klik tombol On/Off untuk mulai melakukan Aktivasi/Inaktivasi
kompetensi audit tersebut
4. Pada halaman Activate/Inactivate Audit Competencies perhatikan Warning
Message. Jika awalnya akun berstatus Active, maka seharusnya pesan yang
tertulis adalah suatu konfirmasi bahwa benar kita akan melakukan Inactivate

(Inaktivasi) terhadap kompetensi audit tersebut

# ) Master Data > Audit Competencies > Activate/Inactivate

Activate/Inactivate Audit Competencies

& Primary Information

Auention!
You are about 1o Inactivate this Audit Competencies by clicking “OnjOff button
7
Competency Code * BASICAUDIT
Max. 20 characters length of Competency Code
Name * Audit Tingkat Dasar
Level » Primary ¥
Description Kompetensi audit tingkat dasar
A
Active

Gambar 190. Halaman Aktivasi/Inaktivasi Audit Competencies (Inaktivasi)
5. Begitupun sebaliknya, jika status awal kompetensi audit Inactive, maka
seharusnya pesan yang tertulis adalah suatu konfirmasi bahwa benar kita

akan melakukan Activate (Aktivasi) terhadap kompetensi audit tersebut
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# > Master Data > Audit Competencies » Activate/Inactivate

Activate/Inactivate Audit Competencies

o
Onloff
& Primary Information

Attention!

You are about to Activate this Audit Competencies by clicking "OnjOff button

Competency Code * BASICAUDIT

Max. 20 characters length of Competency Code

Name * Audit Tingkat Dasar

Level » Primary v

Description Kompetensi audit tingkat dasar

Active

Gambar 191. Halaman Aktivasi/Inaktivasi unit kerja (Aktivasi)

On/Off m untuk submit form untuk menyimpan

Competencies Lists dan lihat pada kolom Status

3.2.16 Menu User Activity Log

Jika sudah yakin akan Aktivasi/Inaktivasi kompetensinya, silakan klik tombol

Untuk melihat status Aktif/Non-Aktif silakan menuju ke halaman Audit

Menu User Activity Log berisi informasi history aktifitas seluruh user yang terdaftar

di aplkasi SIAIS. Menu ini hanya dapat di lihat oleh user dengan role Admin saja.

Data yang ditampilkan yaitu tanggal/waktu aktifitas, IP address user, username,

tipe aktifitas, method di aplikasi yang berkaitan dengan aktifitas tersebut, dan

deskripsi tambahan yang informatif. Berikut adalah tahapan cara mengakses

halaman User Activity Log:

1.

terlebih dahulu ke dalam aplikasi SIAIS

di bagian paling bawah susunan menu)

Untuk menuju ke halaman User Activity Log, pastikan Anda sudah login

Kemudian pada dashboard menu silakan klik menu User Activity Log (letaknya
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#  Dashboard

@ Dasf

I

Gambar 192. Mengakses menu User Activity Log

3. Setelah itu maka akan tampil halaman User Activity Log

# > User Activity Log > List

@ User Activity Log

Show 10 v entries

Search.
NEW OLD

NoO. DATE/TIME  IPADDRESS USER TYPE METHOD DATA DATA DESCRIPTION

1 2021-0803 127001  wieafia I shvioginHandier user usemame-rie afia berhasil login
060059

2 2021-07-31 127001 yuniswano = authvioginhandler user usemame=yun iswanto berhasil login
10:59:39

3 20210730 127001 hesiyann EEE ouviogout sser isemanme=heriyanni beshasd logout
04018

4 202107-30 127001  heriyanni EXl  LhaploadLhaverity belum berhasil verifikasi file LHA file_id33
201733

5 2021-0730 127001  heriyonni 0 sunvioginHandier user usememe=heriyanni berhasil login
2016:40

6 20210730 120001  ohmodbinadt  [EEEEE  autviogout user usemame=ahmad.binadi beshasi logout
201633

7 2021-07-30 127001  ahmad binadi = awthvioginHandler user usemname - ahmad binadi berhasil login
191636

8 20210730 127001  hesiyanni authviogout user usemames=heriyanni berhasil logout
19:16:33

9. 2021073 120001  heryanni I ouovioginHandier user usemame=heriyanni bechasillogin
190430

Gambar 193. Halaman User Activity Log
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